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IMPORTANT–READ C
(“EULA”) is a legal ag
entity) and Captaris, In
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associated media, prin
(“Product”).

YOU AGREE TO BE 
INSTALLING, COPYI
WHOLE OR PART. IF
EULA, DO NOT INST
SHOULD PROMPTLY
RETURN OF THE PR

IF YOU HAVE NOT PA
HAVE ACQUIRED AN
IS GOVERNED BY T
PRODUCT AS AN EV
ACCOUNTS AND TH
PROVISIONS OF TH
RIGHT TO USE THE EVALUATION EDITION UNDER THIS EULA WILL 
AUTOMATICALLY TE
AUTOMATICALLY CE
INSTALL IT UNLESS
PRODUCT BEFORE
COMPONENTS OF 
EXCEPT FOR AN EV
UNDER THIS EULA 
PRODUCT FOR WH

STALLATION PROCESS, WE 
TALL AND RUN THE PREREQUISITE 
RIBED IN THE DOCUMENTATION. IF YOU 
E PREREQUISITE APPLICATIONS DISK, 
TAINED IN THIS EULA WILL NOT APPLY 
EQUISITE APPLICATIONS DISK 
ED BY THIRD PARTIES (“THIRD PARTY 

RTY PROGRAMS ARE SUBJECT TO THIS 
ENSE AGREEMENTS THAT ACCOMPANY 

THAT THE THIRD PARTY PROGRAMS ARE 
 IS” AND WITHOUT ANY WARRANTIES 

MPLIED.

ons herein, Captaris grants you a 
personal license to install, run and use one 
ided as part of the Product on a single server 
u for use in the capacity for which you have 
f this EULA, the capacity licensed by you is 

r of ports (also referred to as channels), seats, 
CPUs, user accounts, or other capacity limitations on which software pricing is 
based. As an exception to the restriction set forth in the first sentence of this 

 on which the server software may be 
 use the following server software 
ber of servers owned or controlled by you; 
se fee for such software and such software is 
d RightFax Server module: Workserver, 

 Service, Faxrpc, Exchange Gateway, SMTP 
 WPO Gateway, SAP Gateway, Isolated 
odule, and Lotus Notes module.
RMINATE AND THE PRODUCT WILL 
ASE FUNCTIONING THIRTY (30) DAYS AFTER YOU 
 YOU PURCHASE A LICENSE AND ACTIVATE THE 
 THE END OF SUCH THIRTY (30) DAY PERIOD. THE 
THE PRODUCT ARE LICENSED SEPARATELY AND, 
ALUATION EDITION, YOUR LICENSE RIGHTS 
EXTEND ONLY TO THE COMPONENTS OF THE 
ICH YOU HAVE PAID THE LICENSE FEE.

section on the number of servers
installed, you may install, run and
components on an unlimited num
provided, you have paid the licen
used only with a properly license
DocTransport, Sync, Production
Gateway, Lotus Notes Gateway,
Engine Conversion, Java/XML m
 9.3 End User License Agreement

AREFULLY: This End User License Agreement 
reement between you (either an individual or a single 
c. (“Captaris”) for the Captaris software product 

h includes computer software and may include 
ted materials, and “online” or electronic documentation 

BOUND BY THE TERMS OF THIS EULA BY 
NG OR OTHERWISE USING THE PRODUCT, IN 
 YOU DO NOT AGREE TO THE TERMS OF THIS 
ALL, COPY OR USE THE PRODUCT. INSTEAD, YOU 
 CONTACT CAPTARIS FOR INSTRUCTIONS ON 
ODUCT.

ID A LICENSE FEE FOR THE PRODUCT, THEN YOU 
 EVALUATION EDITION OF THE PRODUCT, WHICH 

HIS EULA, EXCEPT THAT YOUR RIGHT TO USE THE 
ALUATION EDITION IS LIMITED TO TWO (2) USER 
E WARRANTIES AND CERTAIN OTHER 
IS EULA DO NOT APPLY AS STATED BELOW. YOUR 

AS THE FIRST STEP IN THE IN
RECOMMEND THAT YOU INS
APPLICATIONS DISK AS DESC
DO NOT INSTALL AND RUN TH
THEN THE WARRANTIES CON
TO THE PRODUCT. THE PRER
INCLUDES PROGRAMS OWN
PROGRAMS”). THE THIRD PA
EULA AND ANY SEPARATE LIC
SUCH PROGRAMS, EXCEPT 
FURNISHED BY CAPTARIS “AS
OF ANY KIND, EXPRESS OR I

Server Software License 

Subject to the terms and conditi
non-exclusive, non-transferable, 
copy of the server software prov
that is owned or controlled by yo
paid license fees. For purposes o
determined based on the numbe
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disassemble or attempt to discover the source 
ated to the Product, except and only to the 
sly permitted by applicable law 

rivative works of the Product;
rrent user limitations for the license purchased 

copyright notice or other proprietary rights 

nchmark testing using the Product to any third 

umvent any methods employed by Captaris to 
ts, features or functions of the Product.

udit your compliance with the terms of this 
s to Captaris to facilities, equipment, books, 
therwise reasonably cooperate with Captaris 
it.

 of Captaris and its suppliers and is protected 
al property laws and treaties. Captaris or its 
nterest in and to the Product and all copyright 
hts in the Product.

Provided that you installed and ran the prerequisite application disk in 
accordance with the documentation provided with the Product, Captaris 

ents of the Product for which you have paid 
erform substantially in accordance with the 
or a period of thirty (30) days from the date of 
ermitted by applicable law, Captaris’s and its 
 exclusive remedy for failure of the software to 
ty is, at Captaris’s option, either (a) return of 
e nonconforming components of the Product 
conforming components of the Product by 
 of the components of the Product that does 
oing warranty is void if the failure is due to 
aptaris reserves all rights not expressly granted to you in this EULA. Without 
imiting the foregoing, you will not, and you will not authorize or permit any third 
arty to:
a) use the Product for any purpose other than your internal business 
urposes;
b) use an Evaluation Edition for any purpose other than your evaluation and 
esting of the Product during the thirty (30) day evaluation period;
c) license, distribute, lease, rent, lend, transfer, assign or otherwise dispose of 
he Product or use the Product in any commercial hosted or service bureau 
nvironment;

warrants to you that the compon
the applicable license fees will p
accompanying Product manual f
receipt. To the maximum extent p
suppliers’ entire liability and your
conform to the foregoing warran
the license fee paid by you for th
in exchange for return of the non
you, or (b) repair or replacement
not meet the warranty. The foreg
lient Software License

ubject to the terms and conditions herein, Captaris grants you a 
on-exclusive, non-transferable, personal license to install, run and use the 
lient software provided as part of the Product on an unlimited number of client 
omputers or devices that are owned or controlled by you for use in the 
apacity for which you have paid license fees and solely with the server 
oftware properly licensed by you under this EULA.

ocumentation

ou may make and use a reasonable number of copies of any documentation 
rovided with the Product; provided, that such copies will only be used for 

nternal business purposes in connection with the components of the Product 
or which you have paid the applicable license fees and are not to be 
epublished or redistributed (either in hard copy or electronic form) beyond 
our premises.

ackup 

ou may make one copy of the Product for back-up and archival purposes.

pdates 

ny software provided to you by Captaris which updates or supplements the 
riginal Product is governed by this EULA unless separate license terms are 
rovided with such updates or supplements, in which case, such separate 

erms will govern.

icense Limitations 

xcept with respect to an Evaluation Edition, the preceding licenses apply only 
o the extent you have ordered and paid for the applicable licenses. The 

(d) reverse engineer, decompile, 
code for or any trade secrets rel
extent that such activity is expres
notwithstanding this limitation;
(e) modify, alter or create any de
(f) exceed the capacity or concu
by you; or
(g) remove, alter or obscure any 
notice on the Product;
(h) disclose the results of any be
party; or
(i) circumvent or attempt to circ
control access to the componen

Audit 

Captaris shall have the right to a
EULA. You agree to grant acces
records and documents and to o
in order to facilitate any such aud

Ownership 

The Product is valuable property
by copyright and other intellectu
suppliers own all right, title and i
and other intellectual property rig

Limited Warranty 
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TH ABOVE, CAPTARIS AND ITS 
UCT “AS IS” AND WITH ALL FAULTS. 
EREBY DISCLAIM ALL OTHER 
 OR STATUTORY, ARISING BY LAW 

T NOT LIMITED TO ANY IMPLIED 
LITY, FITNESS FOR A PARTICULAR 
NINFRINGEMENT, WITH REGARD TO 
G THE FOREGOING, CAPTARIS 

PRODUCT WILL BE FREE OF BUGS, 
EFECTS.

 ITS SUPPLIERS BE LIABLE FOR THE 
CIDENTAL, INDIRECT, SPECIAL, 

SIMILAR DAMAGES OR LIABILITIES 
 NOT LIMITED TO LOSS OF DATA, 
T OR BUSINESS) ARISING OUT OF 
ABILITY TO USE THE PRODUCT OR 
NECTION WITH THIS EULA OR THE 
 CONTRACT, TORT (INCLUDING 

 OR OTHER THEORY EVEN IF 
F THE POSSIBILITY OF SUCH 

Limitation of Liability 

 ITS SUPPLIERS’ LIABILITY ARISING OUT OF OR 
E USE OR INABILITY TO USE THE PRODUCT OR 
DER OR IN CONNECTION WITH THIS EULA OR THE 
ITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR 
EGARDLESS OF THE AMOUNT OF DAMAGES YOU 

 WHETHER BASED ON CONTRACT, TORT (INCLUDING 
TRICT LIABILITY OR OTHER THEORY. The foregoing 
nties, disclaimer of certain damages and limitation of liability 
ximum extent permitted by applicable law. The laws of some 
 do not allow the exclusion of implied warranties or the 
ion of certain damages. To the extent that those laws apply 
xclusions and limitations set forth above may not apply to 
nt prorated over three (3) years from the date of purchase. The 
 indemnification obligations do not apply to an Evaluation Edition or 

 Party Programs.

CAPTARIS’S AND
RELATING TO TH
OTHERWISE UN
PRODUCT IS LIM
THE PRODUCT R
MAY INCUR AND
NEGLIGENCE), S
disclaimer of warra
will apply to the ma
states/jurisdictions
exclusion or limitat
to this EULA, the e
you.
, abuse or misapplication and does not apply to an Evaluation Edition 
ird Party Programs. Any replacement Product will be warranted for the 
r of the original warranty period, if any.

fication 

 will defend you against any judicial proceeding based upon a third 
im that the components of the Product for which you have paid the 
le license fee infringes any U.S. patent, U.S. trademark, copyright or 
ret and will indemnify you against any damages, judgments and costs 
arded against you in such proceeding; provided that, you: (a) give 
 prompt written notice of the claim; (b) permit Captaris to control the 
and settlement of the claim; and (c) cooperate with Captaris in the 
and settlement of the claim. Captaris's defense and indemnification 
ns will not apply to any actual or alleged infringement based upon: (i) 
ion of the Product by anyone other than Captaris, (ii) abuse, 
ation or casualty loss, (iii) use of the Product in combination with any 
gram or device, if such infringement would have been avoided but for 
ification or combination, or (iv) failure to install or use any error 

ns, fixes or other updates furnished by Captaris, if such infringement 
ve been avoided by such installation or use. In the event any 
nt of the Product licensed by you or your use of such component is 
fringe or in Captaris’s reasonable judgment is likely to infringe any 
y intellectual property right, Captaris may, at its option, (x) obtain a 
r you to continue to use such component, (y) modify the component 

 is noninfringing, or (z) terminate this EULA as it pertains to such 

Disclaimer of Warranties 

EXCEPT AS EXPRESSLY SET FOR
SUPPLIERS PROVIDE THE PROD
CAPTARIS AND ITS SUPPLIERS H
WARRANTIES, EXPRESS, IMPLIED
OR OTHERWISE, INCLUDING BU
WARRANTIES OF MERCHANTABI
PURPOSE OR USE, TITLE AND NO
THE PRODUCT. WITHOUT LIMITIN
DOES NOT WARRANT THAT THE 
ERRORS, VIRUSES OR OTHER D

Disclaimer of Certain Damages 

IN NO EVENT WILL CAPTARIS OR
COST OF COVER OR FOR ANY IN
PUNITIVE, CONSEQUENTIAL OR 
WHATSOEVER (INCLUDING, BUT
INFORMATION, REVENUE, PROFI
OR RELATING TO THE USE OR IN
OTHERWISE UNDER OR IN CON
PRODUCT, WHETHER BASED ON
NEGLIGENCE), STRICT LIABILITY
CAPTARIS HAS BEEN ADVISED O
DAMAGES.
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 is held by a court of competent jurisdiction to be 
ble, the remainder of this EULA will remain in full 

parties that this Agreement and all related 
nglish. C'est la volonté expresse exigé par les 
 et tous les documents y afférents, soient rédigés 

ire agreement of Captaris and you with respect to 
 matter hereof and supersedes all prior and 
dings and agreements whether written or oral. No 
waiver of any of the provisions of this EULA will be 
itten instrument signed by the party to be bound 
o the contrary. The 1980 U.N. Convention on Contracts for the International 
ale of Goods or any successor thereto does not apply. You hereby irrevocably 
ubmit to jurisdiction of the state and federal courts located in King County, 
ashington with respect to any proceeding under this EULA or relating to the 

roduct. You will not prosecute any action, suit, proceeding or claim arising 
nder or by reason of this EULA except in such courts. 

ttorneys' Fees

n any action or proceeding to enforce rights under this Agreement, the 
revailing party will be entitled to recover costs and reasonable attorneys' fees. 
xport Restrictions

ou acknowledge that the Product is subject to U.S. export restrictions. You 
gree to comply with all applicable laws and regulations that apply to the 
roduct, including without limitation the U.S. Export Administration 
egulations.

.S. Government License Rights 

ll Product provided to the U.S. Government is provided with the commercial 
icense rights and restrictions described in this EULA. By installing, copying or 
sing the Product, the U.S. Government agrees that the Product is 
commercial computer software” or “commercial computer software 
ocumentation” within the meaning of FAR Part 12.

rademarks

his EULA does not grant you any rights in connection with any trademarks or 
ervice marks of Captaris or its suppliers.

ermination

ithout prejudice to any other rights, Captaris may terminate this EULA if you 
o not abide by the terms and conditions contained herein. Upon termination of 

his EULA, you must cease use of the Product and destroy all copies of the 
roduct and all of its component parts.

ransfer

ou may not transfer your rights under this EULA to any third party.

overning Law; Jurisdiction 

nless expressly prohibited by local law, this EULA is governed by the laws of 

Severability

If any provision of this EULA
invalid, illegal, or unenforcea
force and effect.

English Language

It is the express wish of the 
documents be drawn up in E
parties que cette convention
en anglais seulement.

Entire Agreement

This EULA sets forth the ent
the Product and the subject
contemporaneous understan
amendment, modification or 
valid unless set forth in a wr
thereby.
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 requirements

z or higher Pentium III-compatible CPU

 RAM

ee space

nd dual CPU systems

M or DVD drive

 higher resolution monitor running at a 
on of 800 × 600 or higher

d

z or higher Pentium III-compatible CPU

 RAM

ee space

nd dual CPU systems

M or DVD drive
er 1

dware and Software Requirements

erver Requirements
any of the software requirements associated with RightFax 9.3 

re provided on the Prerequisites CD that is shipped with RightFax. 
o determine the needs of your fax server, you must first run 
rerequisites CD, which will in-turn launch the RightFax 
rerequisites Wizard. The Prerequisites Wizard must be run prior 

o installing the RightFax server software and will perform a system 
heck for required third-party components and if necessary, will 

nstall them to your system. Some components, such as Windows 
ervice packs and Microsoft Exchange are not provided. For more 

nformation see “Running the Prerequisites Wizard”on page 21 of 
he installation guide. 

ported Windows Operating Systems
Microsoft Windows Server 2003 Standard Edition

Microsoft Windows Server 2003 Enterprise Edition

Microsoft Windows Server 2003 Datacenter Edition
Microsoft Windows 2000 Advanced Server with SP4 installed

Microsoft Windows 2000 Server with SP4 installed
Microsoft Windows 2000 Datacenter Server with SP4 installed

Minimum hardware requ

Recommended hardware

Computer/Processor 500 MH

Memory 512 MB

Hard drive 1 GB fr

CPU support Single a

Drive CD-RO

Display VGA or
resoluti

Keyboard Require

Computer/Processor 966 MH

Memory 512 MB

Hard drive 2 GB fr

CPU support Single a

Drive CD-RO
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 to a SQL server already configured on your 
supports only the following versions of Microsoft 

000 Standard Edition

000 Enterprise Edition (standalone server)
000 Enterprise Edition (in a SQL clustering 

erver 2005 Express

005 Standard Edition

005 Enterprise Edition (standalone server)
005 Enterprise Edition (in a SQL clustering 

 is not supported.

tional character sets
tabase

htFax client applications have localized versions that 
eakers to easily use the RightFax client tools. See 
te list of the languages available in the RightFax 
he languages into which the RightFax client 
slated are not related to the character sets that can 
tFax database as discussed in this section.

 a wide range of characters and symbols from 
ets. However, the RightFax server, SQL 

nt applications must all be configured to use the 
 If not, characters may not appear on your 
axes as expected. This is because a character 
computer that is using one symbol set may map 
ent character when sent to a server using a 
t.
Additional requirements
� Internet Explorer 6 SP1

� MDAC 2.8

� .NET Framework 1.1 or higher
All RightFax servers and remote BoardServer computers require 
and that the Microsoft Data Access Components (MDAC) be 
updated to the most recent version (version 2.8) on all supported 
operating systems. If your RightFax server has not been updated to 
use MDAC version 2.8, the Prerequisites Wizard will install it for 
you. To update the MDAC on remote servers, run the file 
MDAC_typ.exe located in the \Prereqst folder on the root of the 
RightFax Prerequisites CD.

Microsoft .Net Framework 1.1 is also required by all RightFax 
servers and remote BoardServer computers. The Prerequisites 
Wizard will scan your fax server and will install .Net Framework 1.1 
if required. Those environments choosing to install SQL Server 
2005 Express will be prompted to install .Net Framework 2.0. This 
is again accomplished during the Prerequisites Wizard scan. To 
update or install .Net Framework on remote servers, run the file 
dotnetfx.exe located in the \Prereqst folder on the root of the 
RightFax Prerequisites CD.

Supported Versions of Microsoft SQL Server
RightFax uses a SQL database to store all data on faxes, users, 
and dialing rules. During installation, you have the option to 
connect to an existing SQL database on your network, or can use 
the RightFax Prerequisite wizard to install and use a SQL Server 
2005 Express database directly on the RightFax server. If you 

choose to connect
network, RightFax 
SQL server:

� Microsoft SQL 2

� Microsoft SQL 2
� Microsoft SQL 2

environment)

� Microsoft SQL S

� Microsoft SQL 2

� Microsoft SQL 2
� Microsoft SQL 2

environment)

Note  MSDE 2000

Support for interna
in the RightFax da

Tip  Many of the Rig
allow non-English sp
page 37for a comple
client applications. T
applications are tran
be stored in the Righ

RightFax supports
non-English alphab
database, and clie
same symbol sets.
clients’ outbound f
written on a client 
to an entirely differ
different symbol se

Display SVGA or higher resolution monitor running at a 
resolution of 800 × 600 or higher

Keyboard Required
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are supported by the RightFax server 

aeroese, Hungarian, Polish, Romanian, 
venian)

garian, Russian, and Ukrainian)
, Catalan, Danish, Dutch (Standard and 
ritain, Canada, New Zealand, Australian, 
, French (Standard, Belgium, 
xem.), German (Standard, Swiss, 
nstein), Icelandic, Indonesian, Italian 
egian (Bokmal, Nynorsk), Portuguese 
sh (Mexico, Traditional, Modern), and 

 and Lithuanian)

 using the printer’s available symbol set 
n use on the server. For characters on these 
the code page on the fax server must match 
l set. Because TTI lines and quick headers 
 by your fax board, RightFax does not 
characters on these lines.

port

base does not store double-byte 
rs are supported by server-side 
nt conversion. When you install and 
anguage support options to Microsoft 
int, RightFax will successfully convert 
he symbol sets that are supported on the RightFax server and 
lient computers are determined by the Regional and Language 
ptions configured from Windows Control Panel and can be 

hanged at any time. The symbol set used by the SQL database, 
owever, is encoded into the database when it is installed based 
n the current Regional setting on the SQL server. This is true 
hether you have a separate SQL server or are installing the SQL 
erver during the RightFax installation. You should ensure that the 
egional setting on the SQL server is properly configured for the 
haracter set that the server will support before installing the 
atabase. If you have already installed a SQL database with the 

ncorrect Regional setting, contact Microsoft for assistance in 
econfiguring the SQL regional setting.

The following code pages 
and client applications:

� 1250 (Albania, Croatia, F
Serbian, Slovak, and Slo

� 1251 (Byelorussian, Bul
� 1252 (Afrikaans, Basque

Belgium), English (US, B
Ireland, S.Africa), Finnish
Switzerland, Canada, Lu
Austrian, Luxem., Liechte
(Standard, Swiss), Norw
(Standard, Brazil), Spani
Swedish)

� 1253 (Greek)

� 1254 (Turkish)
� 1255 (Hebrew)

� 1256 (Arabic)

� 1257 (Estonian, Latvian,
� 1258 (Vietnam)

Note  Time strips are printed
regardless of the code page i
lines to appear as expected, 
the printer’s available symbo
are placed onto the fax image
support the use of diacritical 

Double-byte character sup

Although the RightFax data
characters, these characte
application native docume
configure the appropriate l
Word, Excel, and PowerPo
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ines
n be used for incoming or outgoing faxes. A line 
 the local telephone company if one is not 
rough your organization’s existing phone 
 lines are also called POTS (Plain Old Telephone 

(DID) phone lines
ne is called a “trunk.” When a DID trunk is 
ned a bank of numbers. For example, a DID 
ned the bank of 20 numbers ranging from 
469. All calls to any of the assigned numbers 
ID trunk.

ve a few special attributes. First, DID lines are 
faxes only. Outgoing faxes must be sent through 
art line. Second, the customer, rather than the 
upplies the power (called the “talk battery”) 
 the phone line. For this reason, DID fax boards 
tional power adapter which provides the 
t current.

ax to route incoming faxes to their intended 
 your company. Whenever someone dials a 
range, the DID trunk is activated by the phone 
ax board accepts the incoming fax. Along with 
one company sends the board the last three or 
one number dialed. The fax board collects these 

them to RightFax. Each RightFax user has a 
x which is assigned one of the DID trunk’s 

s the “routing code”). Received faxes are routed 
se routing code matches the dialed DID number.

g a loop-start phone line into a DID fax board when 
present on the phone line. Doing so will damage the 
ll warranties.
double-byte documents to fax images. For more information on 
server-side application conversion, refer to the RightFax 
Administrator’s Guide.

Note  Although double-byte characters added to the text of a Microsoft 
Word cover sheet will convert correctly, double-byte characters inserted 
into DocVariable fields on Microsoft Word cover sheets will not.

Fax Board Requirements
RightFax supports Brooktrout fax boards, Intel Dialogic (also known 
as GammaLink) fax boards, and Eicon fax boards. For a list of all 
supported fax board types, refer to the RightFax Fax Board Guide.

Installing the fax boards
Fax boards can be installed in the computer running the RightFax 
server software, or on a separate computer called a Remote 
BoardServer. For information on using Remote BoardServer 
computers, refer to the RightFax Administrator’s Guide.

Phone Line Requirements
The fax boards that RightFax supports can make use of several 
different types of phone lines: loop-start (regular analog phone 
lines), Direct Inward Dial (DID), Dialed Number Identification 
Service (DNIS), Integrated Services Digital Network (ISDN), and 
several types of digital phone lines. Different types of fax boards 
support different types of phone lines. For information on the types 
of fax boards that are compatible with your available phone lines, 
refer to your fax board supplier or manufacturer.

Loop-start phone l
Loop-start lines ca
can be installed by
already available th
system. Loop-start
Service) lines.

Direct Inward Dial 
Each DID phone li
installed, it is assig
trunk may be assig
321-7450 to 321-7
are routed to the D

DID phone lines ha
used for incoming 
a standard loop-st
phone company, s
necessary to drive
come with an addi
necessary –48 vol

DID allows RightF
destinations within
number within the 
company and the f
the fax data, the ph
four digits of the ph
digits and passes 
personal fax mailbo
numbers (known a
to the mailbox who

Warning  Never plu
there is any voltage 
fax board and void a
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ed Number Identification Service (DNIS) phone lines
NIS is a T1-based version of DID service. For information on 
onfiguring your fax boards for DNIS, refer to the hardware guide 

ncluded with your fax board.

grated Services Digital Network (ISDN) phone lines
SDN is a worldwide standard communications network for digital 
ata, voice, and video communication. The main advantages of 

SDN over analog telephone lines are fast call setup and release 
nd additional cost-recovery information included with the call.

, BRI, E1, and T1 digital phone lines
ightFax supports PRI, BRI, E1, and T1 digital phone lines 
ssuming you have purchased and installed the appropriate type of 
ax boards and network interface card. For more information on 
igital phone lines, refer to the RightFax Fax Board Guide.

� � �
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e is installed on the server in the folder 
ion. By default, the software installs in 
tFax folder. Third-party software that is 
r, such as fax board drivers, may be 

.

 Programs
es several configuration programs that 
Fax services. The RightFax configuration 
 Windows Control Panel or from 
escribed in the RightFax Administrator’s 
C

er 2

t Is Installed on the RightFax Server?

he RightFax server installation program installs the complete suite 
f RightFax products. The capabilities of the server and the 
odules that are enabled depend on your product licensing. 
ecause all of the RightFax software is installed, the RightFax 
erver can be upgraded and optional modules can be added simply 
y purchasing a license and activating the feature. For information 
bout upgrading the server and adding new RightFax modules, see 
hapter 5, “Upgrading and Adding Fax Channels, User Licenses, 
nd Optional Components”.

n addition to the installed software, The RightFax installation 
reates several Windows services, adds RightFax configuration 
ettings to the Windows Registry, adds configuration programs to 
indows Control Panel, and installs the FaxUtil and Enterprise Fax 
anager client programs.

ightFax uses a SQL database to store all data on faxes, users, 
nd dialing rules. If you do not connect to an existing SQL 
atabase on your network during installation, RightFax will install 
nd use a SQL Server 2005 Express database on the RightFax 
erver computer. This is a fully functional SQL database, but lacks 
he SQL management tools that accompany the full version of 
icrosoft SQL server.

RightFax Software
All of the RightFax softwar
you specify during installat
the C:\Program Files\Righ
used by the RightFax serve
installed in other locations

RightFax Configuration
The RightFax server includ
let you customize the Right
programs can be run from
Enterprise Fax Manager (d
Guide).
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is is a configuration program used for most of the 
 boards supported by RightFax. Use the 
ardServer configuration program to customize 
ch installed fax board and each fax channel. 
hough you may have only one BoardServer 
rvice installed on a single computer, you can 
tionally create RightFax BoardServer services on 
ote computers to offload fax board processes or 

expand your network’s fax board and fax channel 
pacity. For more information on BoardServers, 
er to the RightFax Administrator’s Guide.

e BoardServer configuration program can only be 
nched from within the Doc Transport program 
scribed next.)

r more information on the fax boards you use and 
ir configuration requirements, and the T.37 and 
8 Fax-over-IP features, refer to the RightFax Fax 
ard Guide. For information on document 
nsport via SMS, refer to the RightFax 
ministrator’s Guide.

e Doc Transport configuration program is used to 
nfigure several transport methods for your 
htFax documents including standard fax boards, 
7 Fax-over-IP, and SMS (short message service).

 fax board configuration, including BoardServer 
nfiguration, is initiated from this configuration 
gram.

r more information on the fax boards you use and 
ir configuration requirements, and the T.37 and 
8 Fax-over-IP features, refer to the RightFax Fax 
ard Guide. For information on document 
nsport via SMS, refer to the RightFax 
ministrator’s Guide.

nfiguration Programs (Continued)

scription
The following table describes all of the RightFax configuration 
programs that are available.

Note  Some of these configuration programs may not be enabled on the 
server, depending on the type of RightFax server you have licensed and 
the modules that are enabled.

Table 2a  RightFax Server Configuration Programs

Configuration 
program Description

Captaris Conversion 
Engine

The Captaris Conversion Engine is a stand-alone, 
fault tolerant service that is used to invoke those 
applications commonly used in server-side 
application conversion. These applications will be 
used to convert their associated file types when 
installed on the RightFax server and remote 
WorkServers.

Captaris Sync The Captaris Sync Module is an XML/XSLT based 
tool that allows RightFax administrators to create 
and synchronize users from Active Directory 
domains, groups, and/or organizational units and/or 
LDAP compliant data sources.

RightFax Alerting Use this program to configure the RightFax Alerting 
and Monitoring feature. This feature lets RightFax 
administrators create custom server statistics to 
monitor and define thresholds on which to send 
alerts. For more information on the Alerting and 
Monitoring feature, refer to the RightFax 
Administrator’s Guide.

RightFax BoardServer Th
fax
Bo
ea
Alt
se
op
rem
to 
ca
ref

Th
lau
(de

Fo
the
T.3
Bo
tra
Ad

RightFax Doc 
Transport

Th
co
Rig
T.3

All
co
pro

Fo
the
T.3
Bo
tra
Ad

Table 2a  RightFax Server Co

Configuration 
program De
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RightFa

RightFa
Gatewa

RightFa

Table 2a  

Configu
program

ogram to create and modify the RightFax 
ay services. SAP gateway services act 
munication link between the RightFax 
 SAP clients. It is possible to install 
P gateways, each communicating with a 

AP client. For more information on the 
ay module, refer to the RightFax 
 for SAP R/3 Guide.

ogram to modify the RightFax Server 
e Server service controls all of the 
ervices and coordinates communication 
e server computer, client computers, fax 
d the fax database. For more information 
tFax Server service, refer to the RightFax 

tor’s Guide.

ogram to create and modify the RightFax 
r services. WorkServer services perform 
rocessor-intensive functions required by 
x server, such as cover sheet generation, 

 conversion, and optical character 
. By default, three separate WorkServer 
e installed on the RightFax server, and 
Server service can be customized to 
ecific functions. You can also create 
orkServer services on remote computers 
our most processor-intensive functions. 
formation on WorkServers, refer to the 
dministrator’s Guide.

n Programs (Continued)

n

C

x EDC Use this program to configure connections between 
RightFax and third-party document delivery systems 
such as FileNet applications and Xerox 
multi-function products. The RightFax EDC (External 
Document Connector) is a generic connector that 
allows the RightFax server to communicate with 
external systems. Instructions for how to configure 
the RightFax EDC are included in the 
documentation for each supported external system.

x E-mail 
y

Use this program to create and modify the RightFax 
e-mail gateway services. E-mail gateway services 
act as the communication link between the RightFax 
server and your organization’s e-mail software. It is 
possible to install multiple e-mail gateways, each 
communicating with a different e-mail server. For 
more information on e-mail gateways, refer to the 
RightFax Administrator’s Guide, the RightFax 
Gateway for Microsoft Exchange Guide, or the 
RightFax Gateway for Lotus Notes Guide 
(depending on the gateway you add).

x Integration Use this program to modify the RightFax Integration 
Module service. The Integration Module integrates 
the RightFax server with applications on mainframe, 
mid-range, and local area network host systems. For 
more information on the RightFax Integration 
Module, refer to the RightFax Integration Module 
Guide.

RightFax Server Configuration Programs (Continued)

ration 
Description

RightFax SAP 
Connector

Use this pr
SAP gatew
as the com
server and
multiple SA
different S
SAP gatew
Connector

RightFax Server Use this pr
service. Th
RightFax s
between th
boards, an
on the Righ
Administra

RightFax WorkServer Use this pr
WorkServe
the most p
the RightFa
PCL-to-fax
recognition
services ar
each Work
perform sp
RightFax W
to offload y
For more in
RightFax A

Table 2a  RightFax Server Configuratio

Configuration 
program Descriptio
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plications
ightFax server software, several RightFax client 
ailable that allow administration of the fax 
 Fax Manager), user access to fax mailboxes 
rs that allow users to print documents directly 
livery to the RightFax server (RightFax print 
based versions of these applications. For more 
, Enterprise Fax Manager, the RightFax print 
eb-based equivalent applications, refer to the 
rator’s Guide.

� � �
RightFax Services
The names of all RightFax services begin with the word “RightFax.” 
This lets you easily identify all of RightFax services that are currently 
running. You can modify most RightFax services through their 
configuration programs, which can be run from Windows Control 
Panel or from the RightFax administrative program, Enterprise Fax 
Manager (described in the RightFax Administrator’s Guide).

RightFax Registry Entries
All of the RightFax registry entries are located in the Windows 
Registry under the following keys:

� HKEY_CURRENT_USER\SOFTWARE\RightFax

� HKEY_CURRENT_USER\SOFTWARE\RightFax Client
� HKEY_LOCAL_MACHINE\SOFTWARE\RightFax

� HKEY_LOCAL_MACHINE\SOFTWARE\RightFax Client
� HKEY_CLASSES_ROOT\RF...

� HKEY_CLASSES_ROOT\RightFax...

In most cases, you should not have to make changes or additions 
to the RightFax registry settings. However, some RightFax features 
do require you to make modifications to the Windows Registry. 
Wherever this is true, instructions are provided in the RightFax 
documentation.

RightFax Client Ap
In addition to the R
applications are av
servers (Enterprise
(FaxUtil), print drive
to fax format for de
drivers), and Web-
information FaxUtil
drivers, and the W
RightFax Administ
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Chapt

Inst

Upgra
�

�

�

n 8.7 SP3 version of RightFax, Captaris 
eck the RightFax database for errors. 
rogram, and clean up the database if 
 on DBCheck.exe, refer to the 8.7 
dministrator’s Guide.
that have implemented a local MSDE 
MSDE to SQL Server 2000, SQL 
rver 2005 Express. SQL Server 2005 
RightFax 9.3. The option to upgrade 
05 Express is presented during the 9.3 
E installations cannot be upgraded via 

and must be done so from the local 

up the entire Program Files\RightFax 
 complete backup of your RightFax 
t first stop all RightFax services.
er 3

alling the RightFax Server Software

ding from a Previous Version of RightFax
You can only upgrade to RightFax version 9.3 from RightFax 
versions 8.7 SP3 or 9.0 SP2. If you are running an earlier version 
of RightFax, you must either upgrade your earlier version to 
version 8.7 SP3 or 9.0 SP2, or uninstall the RightFax server and 
perform a new installation of RightFax 9.3.
Support for some fax boards has been discontinued with this 
release. For a complete list of fax boards supported by this 
version, refer to the RightFax Fax Board Guide. If you have 
already installed one or more fax boards that do not appear on 
this list, do not upgrade to this version of RightFax.
In RightFax version 9.3, the proprietary database used in pre 9.0 
versions has been changed to a Microsoft SQL database. During 
an upgrade, all existing RightFax database objects will be 
converted to SQL with no loss of data. The RightFax installation 
allows you to install SQL Server 2005 Express directly on the 
RightFax server, or you can connect to an existing SQL database 
on your network. Note that the version of SQL provided with 
RightFax has limited administrative functionality and includes no 
database backup or maintenance tools. If you do not connect to 
an existing full copy of Microsoft SQL database during 
installation, you will probably need to acquire a suite of SQL 
backup and maintenance tools separately.

� Before upgrading from a
recommends that you ch
Run the DBCheck.exe p
needed. For instructions
version of the RightFax A

� All 9.0 SP2 installations 
database must upgrade 
Server 2005 or SQL Se
Express is shipped with 
MSDE to SQL Server 20
installation. Remote MSD
the RightFax installation 
MSDE computer. 

� Before upgrading, back 
folder structure. To get a
server software, you mus
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/customer_support. This Web site may provide 
tion on installing and upgrading the RightFax 

ghtFax server to version 9.3 software is a three 
 of which requires its own separate CD.

h third-party components are required and if 
ll them running using the Prerequisites Wizard 
age 21.

fax server software described on page 22.

ard software and drivers described on page 23.

are upgrade
enterprise with a complex server and client 
ant to gradually phase in the RightFax software 

Fax server software is backward-compatible with 
ons of the RightFax client software, you should 
e server first, and then upgrade the client 

rs need not all be upgraded at the same time. 
ork of RightFax servers of different versions 

ctionality. The same is true for RightFax client 

stallation of the server on a network with a 
ent system such as SMS, see “Running a silent 
ax server software” on page 35.

Fax client applications, refer to the RightFax 
ide.
� Before upgrading an earlier version of the RightFax remote 
BoardServer software, you must uninstall the existing remote 
BoardServer software. To uninstall RightFax remote BoardServer 
software, run the uninstall program from the Add/Remove 
Programs application in Windows Control Panel. You must then 
perform a new install of both the RightFax server software and fax 
board drivers.

� Before upgrading an earlier version of a Dialogic series fax driver, 
you must remove the existing drivers. To uninstall the drivers, run 
the uninstall program from the Add/Remove Programs 
application in Windows Control Panel. You must then perform a 
new install of the fax board drivers.

� The RightFax Web Client shipped will RightFax versions prior to 
9.0 has been replaced with a completely new Web client called 
RightFax Web Access. If you will be installing RightFax Web 
Access on the same IIS server on which an earlier version of the 
RightFax Web client was installed, you must first uninstall the 
existing RightFax Web Client software. Any custom pages 
designed for your old Web client application will be lost.

� Any existing files for the RightFax SecureDocs Module or 
Enterprise Fax Manager Web Edition will be deleted when you 
upgrade these applications on the Microsoft IIS server. If you 
have created customized files for any of these applications, you 
must save copies of the customized files before upgrading, and 
then merge your customizations into the upgraded files.

� After upgrading a Windows 2003 server from a RightFax version 
prior to version this version, you may receive error messages on 
restart reporting that one or more RightFax services have shut 
down improperly. This is a result of the earlier-version services 
being shut down during installation. These messages can be 
closed and disregarded.

By the time you receive this software, new information or software 
updates may be available. For the latest information on RightFax 
software, visit the RightFax support Web site at 

www.captaris.com
up-to-date informa
server

Overview
Upgrading your Ri
step process, each

1. Determine whic
necessary insta
described on p

2. Install the core 

3. Install the fax bo

Rolling out a softw
If you have a large 
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tes Wizard
ill scan your server for third-party 

r the installation of the following 

re RightFax server software.
ise Fax Manager, FaxUtil, and the 

te BoardServer and other server 
motely to share resources across 

ertified Delivery, RightFax Web Access, 
ightFax applications.
he RightFax Connector for Exchange 
ative Tool for the RightFax Connector.

 has their own set of requirements. The 
etermine the status of these 
ide the option of installing them if 
e of Windows service packs, Exchange 
eir requirement and the need to acquire 
.

as .Net Framework, Windows Installer 
8 are provided on the Prerequisites CD 
e Prerequisites Wizard. Windows 

uired) will also be installed via the 
rading the RightFax Server
hen upgrading a RightFax server, you must upgrade both the 

erver software and the hardware drivers. First upgrade the server, 
hen upgrade the hardware drivers.

he RightFax server upgrade copies your existing RightFax 
atabase to an existing SQL server or lets you install a SQL Server 
005 Express database directly on the RightFax server. SQL 
erver 2005 Express does not include any SQL management tools 
uch as database backup utilities. If you intend to install SQL 
erver 2005 Express, which is provided with RightFax, Captaris 

ecommends that you purchase a separate SQL backup utility and 
ny additional SQL management tools you feel necessary for 
roper management of your RightFax database.

hen installing SQL Server 2005 Express on a computer that is 
unning Windows 2000 or 2003 Server, the Microsoft Data 
ccess Components (MDAC) are automatically updated to MDAC 
.8, the Windows Installer is updated to version 3.0, and .Net 
ramework 2.0 is installed. Each of these is a requirement of SQL 
erver 2005 Express. 

arning  If you will be installing the RightFax database to an existing 
QL server, the SQL server must be configured to use SQL mixed-mode 
uthentication. If the SQL server is set to use NT authentication only, the 
atabase will not install properly. If your SQL server is configured to use 
T authentication, you must set it to use mixed-mode authentication 
efore installing RightFax. After the installation is complete, you can 
e-set the SQL server for NT authentication. For instructions on 
onfiguring RightFax to use NT authentication to the SQL server, refer to 
he RightFax Administrator’s guide.

Running the Prerequisi
The Prerequisites Wizard w
software that is required fo
components:

� RightFax Server: The co
� RightFax Client: Enterpr

RightFax print drivers.

� Remote Services: Remo
components installed re
machines.

� IIS Web Applications: C
and other Web-based R

� Exchange Connector: T
and the MMC Administr

Each of these components
Prerequisites Wizard will d
requirements and will prov
necessary, or as in the cas
and IIS, will inform you if th
and install them separately

Other requirements, such 
version 3.0, and MDAC 2.
and are thus installed by th
Message Queueing (if req



RightFax 9.3 Installation Guide 22

rver screen, select the type of SQL database 
r RightFax:

 connection information for an existing SQL 
ct this option if you have a SQL server already 
our network and want to install the RightFax 
hema directly to that server.

u connect to an existing SQL database, a screen 
ting you for connection and login information so 
rver can access the SQL database. Complete 
this dialog box according to your existing SQL 
 then click Next.

soft SQL Server 2005 Express Database 
ct this option if your do not have or do not have 
 existing SQL 2000 or 2005 Server on your 
htFax will install a stripped-down version of SQL 

rify SQL Server 2005 Express requirements. If 
will be prompted to install MDAC 2.8, Windows 
d .Net Framework 2.0. Upon completing the 
ese components, you will be prompted with the 
05 Express installation. These installations can 
nutes.

rver Information screen, document the SQL 
, and Password. These items are critical and 
mented safely and securely. 

are update is complete, click Finish.

htFax server upgrade

Fax server CD. If AutoRun is enabled, a menu of 
ppears. If AutoRun is not enabled, browse the 
tup.exe. The RightFax install wizard opens.

e opening screen to view the RightFax license 
 must accept the license agreement in order to 
tallation. Click Next.
Prerequisites Wizard, however, this is accomplished by utilizing the 
Add/Remove Windows Components Wizard located in the 
Windows > Add/Remove Programs Control Panel. 

Warning  If Windows Message Queueing is required and you are 
upgrading MSDE to SQL Server 2005 Express, the install of Windows 
Message Queueing will stop all MSDE services.

Important  The Prerequisite Wizard cannot upgrade remote MSDE 
installations to SQL Server 2005 Express. This upgrade must be done 
from the MSDE server and prior to installing RightFax. To install SQL 
Server 2005 Express, run the file SQLEXPR.exe located in the \Prereqst 
folder on the root of the RightFax Prerequisites CD. More information 
about installing SQL Server 2005 Express can be found at 
http://support.microsoft.com. 

Caution  The installation of RightFax 9.3 cannot be stopped or reverted 
for any reason. 

1. Log on to the computer using an ID with NT administrative 
access. If you do not log on with administrative access, the 
upgrade will fail.

2. Insert the RightFax Prerequisites CD. If AutoRun is enabled, a 
menu of install options appears. If AutoRun is not enabled, 
browse the CD and run Setup.exe. The RightFax Prerequisites 
wizard opens.

3. Click Next at the Prerequisites Wizard opening screen. 

4. On the Select RightFax Components screen, select the 
components you wish to install or upgrade. At a minimum these 
should included RightFax Server and RightFax Client. Click 
Next after making your selections. 

5. The Prerequisites Preview screen lists third-party software that 
is required by those components previously selected. Software 
that must be installed will have a status of Not Installed. The 
SQL Server status should have a status of Info Required. Click 
Next to either install required software, or to enter your SQL 
Server information. Should you need to install additional 
software, you may need to re-run the Prerequisites Wizard.

6. On the SQL Se
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 fax board drivers

r has been upgraded, remain logged on 
n ID with NT administrative access.

ware drivers CD. If AutoRun is enabled, 
s appears. If AutoRun is not enabled, 
 Setup.exe. The RightFax install wizard 

ng screen to view the RightFax license 
ccept the license agreement in order to 
. Click Next.

Selection screen, select the type of fax 
ed (Brooktrout and/or Dialogic). Click 

e installation.

onfiguration screen opens, click OK to 
ardware configuration.

 drivers have been installed, click Finish 
ax Fax Board Driver install wizard.
. On the Advanced Options screen, you will be prompted to 
enter configuration information based on your previous RightFax 
installation and the components you selected during the 
Prerequisites Wizard. It is recommended that you do not 
change these settings however, if this cannot be avoided you 
must first re-run the Prerequisites Wizard followed by the 
RightFax server setup. Click Next.

. When the software update is complete, click Finish.

If you have upgraded from 8.7 SP3 and have the RightFax 
SecureDocs Module installed and running, you must complete 
an additional step to make sure that your existing RightFax 
database is properly synchronized with the new SQL database.

. Open a command line prompt.

. Change to the RightFax\WebApps\SecureDocs\Apps folder.

. Run the following command:

synchdb RFServer 4 RightFax SQLLoginID Password

Where RFServer is the name of the RightFax server being 
upgraded. SQLLoginID is the login ID used to access the SQL 
database. This will be the DSN login ID if you are connecting to 
an existing SQL server or “sa” if you installed the MSDE SQL 
database. Password is the password for the SQL login you 
specified. If you installed the MSDE database, the password is 
blank which is indicated by two double quotes.

Examples synchdb RFServ 4 RightFax JaneDoe MyPassword
synchdb RFServ 4 RightFax sa ““

. If the command executed properly, a success message will 
display.

. Finally, all existing SecureDocs recipients will be prompted to 
recreate their login information when accessing SecureDocs 
documents on the SecureDocs Web site.

mportant  If you are upgrading an 8.7 server using foreign code pages, 
ou must select the option of ANSI Mode in the RightFax Server module, 
dvanced tab.

Upgrading the RightFax

1. After the RightFax serve
to the computer using a

2. Insert the RightFax hard
a menu of install option
browse the CD and run
opens.

3. Click Next at the openi
agreement. You must a
continue the installation

4. On the Fax Hardware 
boards you have install
Next.

5. Click Install to begin th

6. When the Transport C
keep your existing fax h

7. When all of the updated
to complete the RightF
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uisites Wizard (see “Running the Prerequisites 
e 25

tFax server software (see “To ensure that your 
 installation goes smoothly and to avoid 
lays, it is important to perform each step in the 
pletely and correctly before proceeding to the 
age 26).

nsed product feature set (see “Enabling Your 
ct Feature Set” on page 27).

oard drivers (see “Installing the Fax Board 
e 28).

ightFax Server, WorkServer, and Doc Transport 
ibed in the RightFax Administrator’s Guide).

rds (described in the RightFax Fax Board 

d other RightFax database objects using 
Manager (described in the RightFax 
 Guide).

eive this software, new information or software 
ailable. For the latest information on installing 
isit the RightFax support Web site at 
/customer_support. This site may provide 
tion on installing and upgrading your RightFax 

ll be installing the RightFax database to an existing 
 server must be configured to use SQL mixed-mode 

 SQL server is set to use NT authentication only, the 
tall properly. If your SQL server is configured to use 
ou must set it to use mixed-mode authentication 
htFax. After the installation is complete, you can 
r for NT authentication. For instructions on 
 to use NT authentication to the SQL server, refer to 

strator’s guide.
Installation Overview

Important  If you are installing RightFax in a Windows 2000 or 2003 
cluster, refer to “Clustering RightFax with Microsoft Windows 2003 
Server” on page 65 for special instructions.

The RightFax server is the computer that runs the fax server 
software. The server performs all the work required for sending and 
receiving faxes, including managing the fax database, converting 
documents into fax images, adding signatures, overlaying forms, 
maintaining logs, printing faxes, and creating fax cover sheets.

The RightFax server installation lets you create a new RightFax 
database on an existing SQL server or install an SQL Server 2005 
Express database directly on the RightFax server. SQL Server 
2005 Express does not include any SQL management tools such 
as database backup utilities. If you intend to install SQL Server 
2005 Express, provided with RightFax, Captaris recommends that 
you purchase a separate SQL backup utility and any additional 
SQL management tools you feel necessary for proper management 
of your RightFax database.

When installing SQL Server 2005 Express on a computer that is 
running Windows 2000 Server, the Microsoft Data Access 
Components (MDAC) are automatically updated to MDAC 2.8, 
unless a newer version already exists on the server.

A complete RightFax server installation is comprised of these major 
tasks:

1. Optionally install the fax boards into your RightFax server 
chassis. If you will be using one or more remote BoardServer 
computers to house the fax boards, you do not need to have fax 
boards installed in the RightFax server computer. For more 
information on using remote BoardServer computers, refer to 
the RightFax Administrator’s Guide.

Note  This step does not include installing the fax board driver 
software. The fax board drivers should be installed only after installing 
the RightFax server software.

2. Run the Prereq
Wizard” on pag

3. Install the Righ
RightFax server
unnecessary de
installation com
next step.” on p

4. Enable your lice
Licensed Produ

5. Install the fax b
Drivers” on pag

6. Configure the R
modules (descr

7. Test the fax boa
Guide).

8. Set up users an
Enterprise Fax 
Administrator’s

By the time you rec
updates may be av
RightFax servers, v
www.captaris.com
up-to-date informa
server.

Warning  If you wi
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authentication. If the
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before installing Rig
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configuring RightFax
the RightFax Admini
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ax server installation goes smoothly and 
s, it is important to perform each step in 
and correctly before proceeding to the 

 using an ID with NT administrative 
g on with administrative access, the 

equisites CD. If AutoRun is enabled, a 
appears. If AutoRun is not enabled, 
 Setup.exe. The RightFax Prerequisites 

quisites Wizard opening screen. 

x Components screen, select the 
o install. At a minimum these should 
ver and RightFax Client. Click Next 
tions.

iew screen lists third-party software that 
mponents previously selected. Software 
ill have a status of Not Installed. The 

uld have a status of Info Required. Click 
uired software, or to enter your SQL 
uld you need to install additional 
 to re-run the Prerequisites Wizard.

reen, select the type of SQL database 
ax:
ng the Prerequisites Wizard
he Prerequisites Wizard will scan your server for third-party 
oftware that is required for the installation of the following 
omponents:

RightFax Server: The core RightFax server software.
RightFax Client: Enterprise Fax Manager, FaxUtil, and the 
RightFax print drivers.

Remote Services: Remote BoardServer and other server 
components installed remotely to share resources across 
machines.

IIS Web Applications: Certified Delivery, RightFax Web Access, 
and other Web-based RightFax applications.
Exchange Connector: The RightFax Connector for Exchange 
and the MMC Administrative Tool for the RightFax Connector.

ach of these components has their own set of requirements. The 
rerequisites Wizard will determine the status of these 

equirements and will provide the option of installing them if 
ecessary, or as in the case of Windows service packs, Exchange, 

nternet Explorer 6.01 and IIS, will inform you if their requirement 
nd the need to acquire and install them separately.

ther requirements, such as .Net Framework, Windows Installer 
ersion 3.0, and MDAC 2.8 are provided on the Prerequisites CD 
nd are thus installed by the Prerequisites Wizard. Windows 
essage Queueing (if required) will also be installed via the 
rerequisites Wizard, however, this is accomplished by utilizing the 
dd/Remove Windows Components Wizard located in the 
indows > Add/Remove Programs Control Panel. 

arning  If Windows Message Queueing is required and you are 
pgrading MSDE to SQL Server 2005 Express, the installation of 
indows Message Queueing will stop all MSDE services.

aution  The installation of RightFax 9.3 cannot be stopped or reverted 
or any reason. 

To ensure that your RightF
to avoid unnecessary delay
the installation completely 
next step.

1. Log on to the computer
access. If you do not lo
upgrade will fail.

2. Insert the RightFax Prer
menu of install options 
browse the CD and run
wizard opens.

3. Click Next at the Prere

4. On the Select RightFa
components you wish t
included RightFax Ser
after making your selec

5. The Prerequisites Prev
is required by those co
that must be installed w
SQL Server status sho
Next to either install req
Server information. Sho
software, you may need

6. On the SQL Server sc
you want use for RightF
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stalling on a Novell network, the SAP Agent, 
X, and Gateway for NetWare must be installed on 
rver. File and Print services for NetWare should be 
lan to connect DOS clients.

Fax server CD. If AutoRun is enabled, a menu of 
ppears. If AutoRun is not enabled, browse the 
tup.exe. The RightFax install wizard opens.

e opening screen to view the RightFax license 
 must accept the license agreement in order to 
tallation. Click Next.

e, organization name, and your product serial 
rompted. Click Next.

ype screen, select Typical Server to install the 
 components, the Enterprise Fax Manager server 
ol, and FaxUtil, the RightFax fax mailbox. If you 
dditional server and client components, select 
Next.

ts you selected during the Prerequisites Wizard 
 the server components listed on Setup 
n. It is recommended that you do add any 
r settings however, if this cannot be avoided you 
 the Prerequisites Wizard followed by the 
 setup. Some of these additional components 
e licensing, and may need additional 
fter the server is installed. For information on 
nts you have licensed, refer to the software 
 card that was included with your RightFax 
ge. When you have selected the components to 
xt.

ed Options screen, you will be prompted to 
l configuration information for the RightFax 
abled options are not required for the feature set 
Caution  7.After it is installed, the RightFax SQL database is 
permanently associated with the name of the RightFax server you are 
installing. If for any reason you need to replace or rebuild this 
RightFax server, the new server must have the exact same network 
identification as the original.

� I will specify connection information for an existing SQL 
server. Select this option if you have a SQL server already 
running on your network and want to install the RightFax 
database schema directly to that server.

Click Next if you connect to an existing SQL database, a screen 
will open prompting you for connection and login information so 
the RightFax server can access the SQL database. Complete 
the options on this dialog box according to your existing SQL 
installation and then click Next.

� Install Microsoft SQL Server 2005 Express Database 
Edition. Select this option if your do not have or do not have 
access to an existing SQL 2000 or 2005 Server on your 
network. RightFax will install a stripped-down version of SQL 
sever. 

Click Next to verify SQL Server 2005 Express requirements. If 
necessary you will be prompted to install MDAC 2.8, Windows 
Installer 3.0, and .Net Framework 2.0. Upon completing the 
installation of these components, you will be prompted with the 
SQL Server 2005 Express installation. These installations can 
take several minutes.

On the SQL Server Information screen, document the SQL 
Server, User ID, and Password. These items are critical and 
should be documented safely and securely. 

8. When the software update is complete, click Finish.

To install the RightFax server software

1. Log on to the computer using an ID with NT administrative 
access. If you do not log on with administrative access, the 
installation and configuration of RightFax will fail.

NoteIf you are in
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your RightFax se
installed if you p

2. Insert the Right
install options a
CD and run Se

3. Click Next at th
agreement. You
continue the ins

4. Enter your nam
number when p

5. On the Setup T
RightFax server
management to
want to install a
Custom. Click 

6. The componen
are reflected in
Features scree
additional serve
must first re-run
RightFax server
require separat
configuration a
which compone
product license
software packa
install, click Ne

7. On the Advanc
enter additiona
installation. Dis
you selected.



Chapter 3 Installing the RightFax Server Software 27

8

9

1

e install wizard installs all of the selected 
but does not fully enable the software. 
must have its licensed feature set 
 do either via the Web, or by contacting 
partment. For more information on 
ature set, see “Enabling Your Licensed 

n page 27.

allation is complete, click the Register 
 your licensed product feature set via 
refer to contact the Captaris support 

our licensed product feature set, click 

 Product Feature Set

 existing RightFax server, your existing 
d this step is unnecessary.

nstallation of RightFax, the server will be 
eature set. To enable the full licensed 
ax server, you must register the software 
 you will be issued a “bump” code that 
t. Captaris provides two methods for 
oftware.

ightFax installation wizard is a Register 
k this button to register your RightFax 

allation. Follow the instructions provided 
lete the registration and enable the full 
x server.
SMTP Host. Enter the name of the SMTP server on your 
network that will transport all SMTP alerts and notifications and 
fax-over-IP messages. If you will not be using SMTP to deliver 
RightFax alerts or send documents via fax-over-IP, you may 
leave this option blank.

IIS User Account. If you have selected to install server 
components that require IIS server, enter the IIS user account 
that RightFax will use to access the IIS server.

RightFax Server Name. This option will only be available when 
installing clients, services, and gateways on remote computers. 
This tells the remote software where to locate the RightFax 
server.

Certified Delivery Webserver. If you are installing the Certified 
Delivery feature of the RightFax SecureDocs Module, enter the 
name of the IIS server on which the Certified delivery Web site 
will be located. Click Next.

. Click Install to begin the installation.

. When prompted, select the service account that the RightFax 
services will use to start. This should be an account with 
administrative privileges on the RightFax server. You can click 
Load Users to list all the user accounts accessible to the server 
computer and select the user account you want.

Note  If you will be accessing files from or printing to Novell queues 
on a NetWare volume, the service account must exist in Novell as an 
account.

0.You will be prompted to add an e-mail gateway. E-mail gateways 
let your organization’s fax users send and receive faxes through 
their e-mail client applications. To add one or more e-mail 
gateways, click Add Gateway and select the type of gateway to 
add. When you add a new gateway, a configuration dialog box 
opens. For information on completing the options in this dialog 
box, refer to the RightFax Administrator’s Guide.

11.On new installations, th
RightFax components, 
The RightFax software 
enabled, which you can
the Captaris support de
enabling the licensed fe
Product Feature Set” o

When the software inst
Online button to enable
the Web. If you would p
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Finish.
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feature set will be retained an

After you complete a new i
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ling a Brooktrout fax board, the Doc Transport 
dialog box will open after the driver files have 
This configuration screen for the RightFax 
odule which lets you configure the methods by 

 will be able to transmit documents. This module 
re fax boards for conventional fax transmission, 
p RightFax for SMS messaging, Fax-over-IP, 
some specific Intel and Eicon fax boards. For 
roperly completing the options in the 
odule Transport Configuration dialog box, 

htFax Administrator’s Guide.

 the Transport Configuration dialog box, click 
lete the RightFax Hardware Module install 

drivers for the Dialogic DM3 fax board series, a 
ic board configuration program must be run. For 
ompleting this installation and subsequent 

efer to the documentation included with your fax 
t your board manufacturer.

d to restart the computer, select Yes.

tFax Web Applications
these Web-based applications that can be 
s running Microsoft IIS version 5.0 or higher:

anager Web Edition (also requires .NET 
r greater)

ccess (also requires .NET Framework 1.1 or 

d Delivery

Server
Registering through the Captaris support department
You can also register your RightFax server by contacting the 
RightFax product support group at (520) 320-7070. The support 
engineer will assist you through the registration process.

Installing the Fax Board Drivers
Regardless of the type of fax boards you use, you must run a 
separate fax board hardware driver install program on all 
computers containing the fax boards after installing the server. This 
install program is provided with your RightFax server software on a 
separate CD labeled “Fax Board Driver Install.”

Follow these steps to install the fax board hardware drivers. Be 
sure to run this installation on all RightFax servers and remote 
BoardServer machines after installing or upgrading the RightFax 
server.

To install the fax board drivers

1. Insert the Fax Board Driver Install CD. If AutoRun is not 
enabled, run Setup.exe. The RightFax Hardware Module install 
wizard opens.

2. Click Next at the opening screen to view the RightFax license 
agreement. You must accept the license agreement in order to 
continue the installation.

3. On the Fax Hardware Selection screen, select the type of fax 
boards you have installed (Brooktrout and/or Dialogic). Click 
Next.

4. Click Install to begin the installation.

5. If you are instal
Configuration 
been installed. 
DocTransport m
which RightFax
lets you configu
as well as set u
DOCPlus, and 
information on p
DocTransport m
refer to the Rig

6. After you close
Finish to comp
wizard.

If you installed 
separate Dialog
information on c
configuration, r
board or contac

7. When prompte

Installing the Righ
RightFax includes 
installed on server

� Enterprise Fax M
Framework 1.1 o

� RightFax Web A
greater)

� RightFax Certifie

� RightFax SOAP 
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or RightFax Web Access
sing Windows Authentication mode and 
Access, then you must configure 
to run as a local Administrator, and then 
that users are able to log in.

ervices

s > Control Panel, then double-click 

cTransport Module and choose 

, then select This account. Enter the 
th local Administrator rights.

for these services:

odule
ule

 Access from a Browser
s has been installed on an IIS server, 
ccess their fax mailboxes from Internet 
r by entering the following URL:

il

 machine name of the IIS server where 

il?server=test
hese IIS applications should not be installed on the same 
omputer as the RightFax server software, even if IIS is installed on 
he RightFax server. Captaris recommends that all IIS applications 
e installed on a dedicated IIS server, separate from the RightFax 
erver.

ip  Servers running Microsoft Windows 2003 do not have IIS installed 
y default. On Windows 2003, IIS 6.0 must be selected as an optional 
omponent during the operating system installation

o install one or more of these applications, access the IIS server 
n which the applications will be installed and run the server 

nstallation (described on page 25). Select the applications to 
nstall under the “IIS” heading in the Setup Features screen.

f you are installing any of these applications on a server running IIS 
ersion 6.0, you must change some of the default settings in the IIS 
onfiguration. These changes can be made either before or after 
ou install the RightFax client applications, but they must be 
ompleted before these applications will work on computers 
unning IIS 6.0:

For Windows 2000 Server and Windows 2003 Server, you must 
register ASP.NET as a Web Service Extension. To do this, click 
Start > Run, then type cmd. Enter the following at the command 
prompt, and press ENTER:

C:\Windows\Microsoft.NET\Framework\v1.*\aspnet_regiis -i
where v1.* is the most recent version of .NET Framework on your 
server.
In Internet Information Services Manager, Active Server Pages, 
ASP.NET, and ISAPI Extensions must be enabled. These 
features are enabled from the Web Service Extensions folder.

Parent Paths must be enabled, either for the Default Web Site as 
a whole, or for the SecureDocs virtual directory which appears 
after the installation of Certified Delivery. Edit the properties of 
either of these sites and select the Directory tab. Click 
Configuration, open the Options tab, and select Enable Parent 
Paths.

Configuring SQL Server f
If you install SQL Server u
plan to use RightFax Web 
specific RightFax services 
edit a configuration file so 

To configure RightFax s

1. Choose Start > Setting
Administrative Tools.

2. Double-click Services.

3. Right-click RightFax Do
Properties.

4. Display the Log On tab
credentials of a user wi

5. Click OK.

6. Repeat this procedure 

� RightFax Database M
� RightFax Server Mod

� RightFax Remoting

Accessing RightFax Web
After RightFax Web Acces
your RightFax clients can a
Explorer version 6 or highe

http://ServerName/WebUt

Where ServerName is the
Web Access is installed.

http://ServerName/WebUt
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lient
 RightFax SOAP client, a RightFax tray icon will 
uter's Start bar. Users can access RightFax 
s through the shortcut menu from this icon. 
t documents directly to the RightFax Fax Printer 
 that the client installation adds), which prompts 
information and transmits the document via the 

tFax Server Installation
ir installation replaces missing or corrupted 
files or Windows Registry settings, and retains 
and configuration settings.

allation

Fax server CD. If AutoRun is enabled, a menu of 
ppears. If AutoRun is not enabled, browse the 
toRun.exe.

install options, select the option to install the 
. The RightFax install wizard opens.

e opening screen, select the Repair option, and 
.

begin the Repair installation.

ir installation is complete, click Finish.
Installing the SOAP client application
The SOAP client installation lets RightFax users use the 
Print-to-Fax feature from any computer with an Internet connection. 
The SOAP server must be installed on an IIS server running version 
9.0 of RightFax Web Access. The SOAP client then accesses 
RightFax through that server. This provides RightFax functionality to 
home-office or other remote employees who do not have direct 
access to your organization's network. There are two components 
to the SOAP installation: install the SOAP server on the IIS 
computer running RightFax Web Access, and then install the 
SOAP client on the remote client computers.

Installing the SOAP Client

When you install the SOAP server on the Web Access IIS server, 
the SOAP client installation file RightFax Client for the Web.exe is 
installed in the Program Files\RightFax\WebApps\WebUtil\Client 
Install folder. You must send this file via e-mail, copy it to a 
removable storage medium, or otherwise make it available to the 
remote clients. Follow these steps on each remote computer to 
install the SOAP client:

1. Run the RightFax SOAP client installation file RightFax Client 
for the Web.exe.

2. At the introductory screen, click Next.

3. Enter the Web address of the SOAP server (e.g., 
www.MyCompany.SOAPServer.com) and the machine name of 
the RightFax server when prompted. Click Next.

4. Click Install to begin the installation. A status bar indicates the 
progress of the installation.

5. When the installation is complete, click Finish.

Using the SOAP C
After you install the
appear in the comp
Print-to-Fax feature
Users can also prin
(a new printer type
for fax addressing 
RightFax server.

Repairing the Righ
The RightFax Repa
RightFax program 
your fax database 

To repair an inst

1. Insert the Right
install options a
CD and run Au

2. In the menu of 
RightFax server

3. Click Next at th
then click Next

4. Click Install to 

5. When the Repa
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ess is complete, click Finish.

on will use the first compatible printer driver 
printer. If no compatible driver is found, 
matically. If this occurs, this driver and its 
moved if RightFax is uninstalled. In a 
d 2003 installation, the printer driver files 
2\Spool\Drivers\W32X86\3 and include 
talling the RightFax Server
o ensure that all RightFax components are completely uninstalled, 
ou must remove all separately installed RightFax components (the 
ax hardware drivers, AutoReply, etc.) before uninstalling the 
ightFax server. These components can be uninstalled from 
dd/Remove Programs in Windows Control Panel.

o uninstall the RightFax server

arningWhen you uninstall the RightFax server, all RightFax program 
iles, Windows Registry settings, and shortcuts are removed. In addition, 
ll of your RightFax configuration settings are removed. The RightFax 
atabase, however is not removed and must be manually removed using 
QL protocols. Captaris recommends that you back up the contents of 

he entire RightFax folder before uninstalling the software. For information 
n creating a backup of the RightFax server, refer to the RightFax 
dministrator’s Guide.

. Insert the RightFax server CD. If AutoRun is enabled, a menu of 
install options appears. If AutoRun is not enabled, browse the 
CD and run AutoRun.exe.

. In the menu of install options, select the option to install the 
RightFax server. The RightFax install wizard opens.

. Click Next at the opening screen, select the Remove option, 
and then click Next.

. Click Remove to uninstall the RightFax server.

5. When the uninstall proc

Note  The RightFax installati
it finds to create the HPFAX 
RightFax will install one auto
associated files will not be re
Microsoft Windows 2000 an
reside at ..Windows\System3
the following:

� HPLJ5.BUD
� HPLJ5.GPD
� PCL5ERES.DLL
� STDNAMES.GPD
� TTFSUB.GPD
� UNIDRV.DLL
� UNIDRV.HLP
� UNIDRVUI.DLL
� UNIRES.DLL 
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lays details of the selected fax server or 
listed on the right, such as individual users or 
 are referred to as database objects. Database 
ed, deleted, and modified according your 

rprise Fax Manager Window

on on configuring fax servers and database 
rprise Fax Manager, refer to the RightFax 
ide.
Using Enterprise Fax Manager
With the Enterprise Fax Manager program, an administrator can 
manage users, groups, signatures, forms, printers, billing codes, 
library documents, and more, for all RightFax servers from one 
application.

Enterprise Fax Manager (EFM) is a client application that can be 
run from any Windows 2000 or Windows 2003 computer, and it is 
installed on the RightFax server computer when you run the server 
installation.

Running the Enterprise Fax Manager program
After the RightFax server software has been installed, run 
Enterprise Fax Manager from the Programs list in the Start menu. 
When you run Enterprise Fax Manager for the first time, it will try to 
log on under your network user ID. If you did not log on to the 
network as “Administrator” a Login dialog box will appear. Enter a 
user ID and password with RightFax administrative access.

Important  When the RightFax server software is installed, a RightFax 
user account is created called “administrator” with a blank password. Use 
this account to open Enterprise Fax Manager for the first time. Once you 
are running Enterprise Fax Manager, you can create a new administrative 
account with password protection.

The Enterprise Fax Manager window
Enterprise Fax Manager displays data and statistics about RightFax 
servers and the components of each server such as users and 
groups. In the left pane of the window is a tree structure that 
displays each of the fax servers on your network and each fax 
server’s components. To appear in this list, a RightFax server must 
be opened. To open a RightFax server on your network, select 
File > Open and enter the name of the server when prompted.

The right pane disp
component. Items 
library documents,
objects can be add
needs.

Figure 3.1  The Ente

For more informati
objects using Ente
Administrator’s Gu
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Table 3a  

Propert

/i

Specifies the path to a log file. Use the 
following flags to indicate the information 
to log:

i - Status messages

w - Nonfatal warnings

e - All error messages

a - Startup of actions

r - Action-specific records

u - User requests

c - Initial UI parameters

m - Out-of-memory or fatal exit 
information

o - Out-of-disk-space messages

p - Terminal properties

v - Verbose output

+ - Append to existing file

! - Flush each line to the log

“*” - Wildcard; log all information except 
the v option. To include the v option, 
specify “/l*v”.

icrosoft Windows Installer (Continued)

Description
ng Silent Installs of the Server
ax Board Drivers

oth the RightFax server and Fax Board Driver installation 
rograms uses Microsoft Windows Installer (Msiexec.exe), which is 
n executable program that interprets packages and installs 
roducts. Msiexec.exe enables you to install or upgrade the 
ightFax server silently (without user interaction or prompts). A 
ilent installation can be used for a large-scale enterprise 
eployment to multiple RightFax servers.

he installation program is not designed to run on a remote 
omputer. To use it to install on a remote computer, a third-party 
pplication such as SMS is required.

he following table describes some of the Msiexec.exe installation 
ommand line options you can use. For more detailed information 
nd additional options, please refer to Microsoft documentation for 
siexec.exe.

Command Line Options for Microsoft Windows Installer

y Parameters Description

path/filename Installs or configures a product from a 
specified path and filename.

Use the format: /i path\filename

/l [i|w|e|a|r|u|c|m|o|p|v
|+|!]Logfile

Table 3a  Command Line Options for M

Property Parameters
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on about installation errors, you must generate a 
option. Problems with the installation or 
receded by “Error” in the log.

s
ss

Force - Always prompts for a reboot at 
the end of the installation. The setup 
program will prompt the user with an 
option to reboot at the end. If there is no 
user interface, the system automatically 
reboots at the end of the installation.

Suppress - Suppresses prompts for a 
reboot at the end of the installation. The 
setup program will prompt the user with 
an option to reboot during the installation 
if it detects that a reboot is required to 
complete the installation. If there is no 
user interface, the system automatically 
reboots if one is required to complete the 
installation. Reboots at the end of the 
installation. For example, reboots that are 
caused by an attempt to install a file in 
use are suppressed.

ReallySuppress - Suppresses all reboots 
and reboot prompts if the setup program 
detects that a reboot is required to 
complete the installation. Suppresses all 
reboots and reboot prompts at the end of 
the installation. Both the reboot prompt 
and the reboot itself are suppressed. For 
example, reboots at the end of the 
installation that are caused by an attempt 
to install a file in use are suppressed. 

ions for Microsoft Windows Installer (Continued)

Description
To obtain informati
log file with the /L 
configuration are p

/q n|b|r|f Sets the user interface level.

n - Setup does not prompt the user for 
information. It does not display progress 
indicators as it installs, and it does not 
display a completion message at the end 
of the installation.

b - Setup does not prompt the user for 
information, but it does display progress 
indicators and a completion message at 
the end of the installation.

r - Setup does not prompt the user for 
information. It does display progress 
indicators as it installs, but it does not 
display a completion message at the end 
of the installation.

f - Setup prompts the user for 
information, and it does display progress 
indicators and a completion message at 
the end of the installation.

Table 3a  Command Line Options for Microsoft Windows Installer (Continued)

Property Parameters Description

reboot Force|Suppres
|ReallySuppre

Table 3a  Command Line Opt

Property Parameters
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 file

 server installation properties and 
ile called ServerProperties.txt. A sample 
ed on the RightFax server CD. 
 the default values. The RightFax server 
le 3c: RightFax Server Installation 

n, the ServerProperties.txt file must 

E

me>
mber>
Domain\UserName>
 = <Password>
 Files\RightFax\

R = <Server>
AME = <User>
ORD = <Password>

Table 3b 

Propert

INSTALL

IS_SQL
DATABA

IS_SQL
PASSW

IS_SQL
SERVE

IS_SQL
USERN

Specify what language the RightFax 
clients will use. This is set to English 
by default.

> Specify the RightFax server the 
clients, IIS, or remote services will 
connect to. For clients, this sets the 
server the client will open when first 
installed. For IIS and remote services 
it is used to specify the server to 
connect to for configuration info or 
settings.

nd Line Options (Continued)

Description
s part of the silent installation, you must install Microsoft 
indows Installer, version 2.0 or later. This program is included on 

he root of the RightFax server CD and is called Instmsiw.exe.

ning a silent install of the RightFax server software
here are also several advanced RightFax command line options 
ou can set, described in the following table. The command line 
ormat for these options is option=“value”

he silent install for RightFax does not support installing a separate 
SDE SQL database on the RightFax server. The silent installation 

ption can only be used when connecting to an existing SQL 
erver.

The install properties text

You must specify RightFax
installed components in a f
properties text file is includ
Unspecified properties use
properties are listed in “Tab
Properties” on page 36.

For a new server installatio
contain these settings:

INSTALL_SERVER = TRU
RFLANGUAGE = English
SMTPHOST = <ServerNa
SERIALNUM = <SerialNu
WORKSRV_USERID = <
WORKSRV_PASSWORD
INSTALLDIR = C:\Program
ALLUSERS = 1
IS_SQLSERVER_SERVE
IS_SQLSERVER_USERN
IS_SQLSERVER_PASSW

 RightFax Advanced Command Line Options

y Parameters Description

LEVEL 1|2|3 Controls what features are visible to 
the user.

� 1 = Clients with no EFM
� 2 = Clients with EFM
� 3 = All features available

SERVER_
SE

<database> The name of the database to create 
on the SQL server. Default is 
RightFax.

SERVER_
ORD

<password> Password used to log on to the SQL 
server if SQL authentication is used.

SERVER_
R

<server> The name of the SQL server to 
connect to.

SERVER_
AME

<user> User name used to log on to the SQL 
server if SQL authentication is used.

RFLANGUAGE <language>

RFSERVERNAME <servername

Table 3b  RightFax Advanced Comma

Property Parameters
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SERVER = <Server>
USERNAME = <User>
PASSWORD = <Password>

Fax silent install performs no error checking. If you 
ponents for which the server does not meet the 

nts, the silent install will fail.

gh which fax documents that are addressed to 

htFax software will be installed.

ot required. You must delete this line or comment 
tallation program. If you keep this property in the 
ber, then the serial number that is stored on your 

rading from an earlier version, this property is not 

tFax services will use to start. This should be an 
r.

rading from an earlier version, this property is not 

e account that the RightFax services will use to 
es on the RightFax server.

ommunicate with. This property is required for all 
For a server upgrade, the ServerProperties.txt file must contain 
these settings:

INSTALL_SERVER = TRUE
RFLANGUAGE = English
ALLUSERS = 1

IS_SQLSERVER_
IS_SQLSERVER_
IS_SQLSERVER_

Caution  The Right
attempt to install com
minimum requireme

Table 3c  RightFax Server Installation Properties

Property Value Description

SMTPHOST <servername> Specify the name of the SMTP server on the network throu
e-mail recipients will be sent.

INSTALLDIR <install path>

Default: c:\program
files\rightfax\

Specify the path and the folder on the server where the Rig

The value must end with a backslash (\).

SERIALNUM <serial number> Specify the product serial number.

This property is required for new installations.

If you are upgrading from an earlier version, this property is n
it from the properties text file so that it is not read by the ins
properties text file without specifying the product serial num
RightFax server will be deleted.

WORKSRV_
PASSWORD

<password> This property is required for new installations. If you are upg
required.

Specify the password for the service account that the Righ
account with administrative privileges on the RightFax serve

The password is case-sensitive.

WORKSRV_USERID <domain\userID> This property is required for new installations. If you are upg
required.

Specify the domain or workgroup and user ID for the servic
start. This should be an account with administrative privileg

Use the format domain\userID.

RFSERVERNAME <server> Specify the RightFax server the modules of the install will c
subfeatures except the server.



Chapter 3 Installing the RightFax Server Software 37

IUSRAC

ALLUSE l for only the current user. This value must 

NUMRE
SERVER

 machine. This number must not push the 

INOUTD nge 2000 Connector feature.

INSTALL

INSTALL

INSTALL

INSTALL

INSTALL

INSTALL
PRINTE

INSTALL

INSTALL
CLIENT

INSTALL

INSTALL

INSTALL

INSTALL

INSTALL
DELIVE

INSTALL
CLIENT

INSTALL
CONNE

Table 3c 

Propert
COUNT <userID> Specify the anonymous IIS user account to use for IIS features.

RS 1 or 0 Specify “1” to install for all users on the system, “0” to have it instal
be set to 1 for a server install.

MOTEWORK
S

<number> Specify the number of remote WorkServers to install on the remote
total number of WorkServers above 16.

IR <path\folder> Specify the directory to put the In/Out directories into for the Excha

_SERVER TRUE Set to “TRUE” to install the RightFax Server feature.

_EFM TRUE Set to “TRUE” to install the Enterprise Fax Manager feature.

_FAXCTRL TRUE Set to “TRUE” to install the RightFax Print Driver feature.

_FAXUTIL TRUE Set to “TRUE” to install the FaxUtil feature.

_OUTLOOK TRUE Set to “TRUE” to install the RightFax Outlook Client feature.

_MAPI
R

TRUE Set to “TRUE” to install the MAPI Print Driver feature.

_VIMPRINTER TRUE Set to “TRUE” to install the VIM Print Driver feature.

_AUTOREPLY TRUE Set to “TRUE” to install the AutoReply Client feature.

_INTERACTION TRUE Set to “TRUE” to install the Interaction Client feature.

_PAPERPORT TRUE Set to “TRUE” to install the Paperport Client feature.

_WEBEFM TRUE Set to “TRUE” to install Enterprise Fax Manager.

_WEBCLIENT TRUE Set to “TRUE” to install the Web Client feature.

_CERTIFIED
RY

TRUE Set to “TRUE” to install the Certified Delivery feature.

_EXCH2K TRUE Set to “TRUE” to install the Exchange 2000 MMC Client feature.

_EXCH2K
CTOR

TRUE Set to “TRUE” to install the Exchange 2000 Connector feature.

 RightFax Server Installation Properties (Continued)

y Value Description
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 feature.
INSTALL_REMOTE
ALERTING

TRUE Set to “TRUE” to install the Remote Alerting and Monitoring

INSTALL_REMOTE
WORKSERVER

TRUE Set to “TRUE” to install the Remote WorkServer feature.

INSTALL_REMOTE
BOARDSERVER

TRUE Set to “TRUE” to install the Remote Boardserver feature.

INSTALL_JAVAXML TRUE Set to “TRUE” to install the Java/XML feature.

Table 3c  RightFax Server Installation Properties (Continued)

Property Value Description
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a batch file that silently installs Microsoft 
RightFax fax board drivers. It generates 
x Hardware.log”:

are install

E=“c:\temp\HardwareProperties.txt” /i 
iver.msi” /q /l*v “%temp%\RightFax 

 additional configuration of the fax 
 configure the boards after installation 
figuration program, refer to the RightFax 

� �

T

he following is an example of a batch file that silently installs 
icrosoft Windows Installer and the RightFax server. It generates 

he log file named “RightFax Server.log”:

echo calling silent install
time /T
siexec PROPERTIESFILE=“c:\temp\ServerProperties.txt” /i 

D:\RightFax Product Suite.msi” /q /l*v “%temp%\RightFax 
erver.log”
time /T

fter the silent installation, additional configuration of the server 
ay be needed. Refer to the RightFax Administrator’s Guide for 

nstructions on configuring the server.

ning a silent install of the fax board drivers
ou must specify fax board driver installation properties at the 
ommand line or in a properties text file. An example properties text 
ile called HardwareProperties.txt is included on the root of the 
ightFax server CD. The fax board driver properties are listed in the 

ollowing table.

Following is an example of 
Windows Installer and the 
the log file named “RightFa

@echo calling silent hardw
@time /T
msiexec PROPERTIESFIL
“D:\RightFax Fax Board Dr
Hardware.log”
@time /T

After the silent installation,
boards may be needed. To
using the BoardServer con
Administrator’s Guide.

� 

able 3d  Fax Board Driver Installation Properties

Property Value Description

BOARD_BROOK TRUE Install Brooktrout fax board drivers. 

You can specify both Brooktrout and 
Intel Dialogic fax board drivers in the 
command.

BOARD_DIALOGIC TRUE Install Intel Dialogic fax board 
drivers.

You can specify both Brooktrout and 
Intel Dialogic fax board drivers in the 
command.



RightFax 9.3 Installation Guide 40



41Document 

Chapt

Inst

T
t
s
r

�

�

�

�

�

�

�

T
l

�

�

�

�

�

�

�

ax client applications to your users’ 
ntify which applications are appropriate 
all only those applications.

a Windows-based application that 
rators access to all RightFax servers on 
 Manager lets administrators manage all 
rver including managing users and other 
and stopping RightFax services, and 
. This application should be installed on 
ightFax administrators will be managing 
 about running Enterprise Fax Manager, 

nistrator’s Guide.

terprise Fax Manager (Enterprise Fax 
 be installed on a Microsoft IIS server on 
of Enterprise Fax Manager provides all 
e Windows version, but is accessible 

ia the Web using any Web browser. This 
anager is not installed as a client 
 on installing Enterprise Fax Manager 
 the RightFax Web Applications” on 
Version xx-xxxx April 21, 2006

er 4

alling the RightFax Client Applications

he RightFax software includes the following client applications 
hat let RightFax users send and receive faxes via the RightFax 
erver and also let administrators manage RightFax servers from 
emote computers:

“Enterprise Fax Manager” (page 41)
“RightFax Print Driver” (page 42)

“FaxUtil” (page 42)

“Outlook Advanced Fax Extensions” (page 42)
“MAPI Print Driver” (page 42)

“VIM Print Driver” (page 42)
“AutoReply Client” (page 42)

hese client applications can be installed in the following 
anguages:

English

French
French-Canadian

German

Italian
Portuguese

Spanish

Before installing the RightF
computers, you should ide
for each user and then inst

Enterprise Fax Manager

Enterprise Fax Manager is 
provides RightFax administ
the network. Enterprise Fax
aspects of the RightFax se
database objects, starting 
monitoring server statistics
all computers from which R
the servers. For information
refer to the RightFax Admi

A Web-based version of En
Manager Web Edition) can
your network. This version 
the same functionality as th
both locally and remotely v
version of Enterprise Fax M
application. For information
Web Edition, see “Installing
page 28.
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I (Messaging Application Programming 
ver lets fax users send fax images as e-mail 
 MAPI-compliant applications such as Microsoft 
 Mail, and Novell Groupwise. When the user 
using this print driver, a MAPI-compliant e-mail 
 opens with the document attached as a TIFF 
sage can then be addressed and sent. This 

 be installed on all computers to which you want 
tionality. Before installing this application, make 

int driver is installed on the client’s computer.

rrently not supported under Windows 2003 

from Excel 97 with the MAPI print driver, in the Excel 
, set the print quality to 200 dots-per-inch (DPI) to 
FF image quality.

(Vendor Independent Messaging) Print Driver 
 fax images as e-mail attachments using 
lications such as Lotus Notes and Lotus cc:Mail. 
ts a document using this print driver, a 
ail application window opens with the document 
 file. The e-mail message can then be addressed 
lication should be installed on all computers to 
 provide this functionality. Before installing this 
ure that a PCL print driver is installed on the 

rently not supported under Windows 2003 

vice monitors one or more RightFax mailboxes 
nd automatically faxes a response to the sender 
der's caller service identification (CSID) 
RightFax Print Driver

The RightFax Print Driver lets users fax documents directly from the 
applications used to create them (such as Microsoft Word.) The 
print driver also installs a RightFax tray icon in the Windows 
taskbar that lets users configure fax options, run fax client 
applications, send faxes, and set the default printer. This 
application should be installed on all computers from which 
RightFax users will be sending and receiving faxes.

FaxUtil

FaxUtil is a Windows-based fax mailbox tool that lets users send, 
receive, view, edit, and manage faxes. This application should be 
installed on all computers from which RightFax users will be 
sending and receiving faxes, unless you will be installing alternative 
client applications such as the RightFax Web Client, the Client for 
Microsoft Outlook (described in the RightFax Gateway for 
Microsoft Exchange Guide), or the Lotus Notes Client (described 
in the RightFax Gateway for Lotus Notes Guide). For information 
about running FaxUtil, refer to the FaxUtil online help which is 
installed with FaxUtil.

A Web-based version of FaxUtil (RightFax Web Access) can be 
installed on a Microsoft IIS server on your network. This version of 
FaxUtil provides all the same functionality as the Windows version, 
but is accessible both locally and remotely via the Web using any 
Web browser. This RightFax mailbox tool is not installed as a client 
application. For information on installing the RightFax Web Client, 
see “Installing the RightFax Web Applications” on page 28.

Outlook Advanced Fax Extensions

The Outlook Advanced Fax Extensions enable advanced fax 
functionality in your users’ Outlook mailboxes. This application 
should be installed on computers running Microsoft Outlook only if 
you will be installing the RightFax Gateway for Microsoft Exchange. 
For information about using the Advanced Fax Extensions, refer to 
the RightFax Gateway for Microsoft Exchange Guide.

MAPI Print Driver

The RightFax MAP
Interface) Print Dri
attachments using
Outlook, Microsoft
prints a document 
application window
file. The e-mail mes
application should
to provide this func
sure that a PCL pr

MAPI printing is cu
Terminal Server.

Note  When faxing 
Page Setup settings
obtain the correct TI

VIM Print Driver

The RightFax VIM 
lets fax users send
VIM-compliant app
When the user prin
VIM-compliant e-m
attached as a TIFF
and sent. This app
which you want to
application, make s
client’s computer.

VIM printing is cur
Terminal Server.

AutoReply Client

The AutoReply ser
for inbound faxes a
based on each sen
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 Client Applications
f the RightFax client applications may not 
ersions of the RightFax server, all of the 
etwork that will be accessed by fax users 
e upgrading the client applications.

applications, complete the steps for 
).

s 8.0 and later, users can create nested 
d in earlier versions. In an environment 
een FaxUtil version 8.0 (or later) and earlier 
 in the later version of FaxUtil won’t appear 
t. Similarly, folders created in earlier 
pear in FaxUtil 8.0. However, folders 
FaxUtil will appear in FaxUtil versions 8.5 

Com

Mem

Har

CP

Driv

Dis

Key

z or higher Pentium-compatible CPU

RAM

ith 650 MB free space

o CPUs per computer

M or DVD drive

nitor running at a resolution of 800 × 
igher

d

C

umber. The AutoReply Client lets administrators configure the 
utoReply service from any computer on the network This 
pplication should be installed on all computers from which 
ightFax administrators will be managing the AutoReply service. 
or information about AutoReply, refer to the RightFax 
dministrator’s Guide.

ax Client Computer Requirements
ightFax client applications for this version can be installed only on 
omputers running the following operating systems:

Microsoft Windows XP Professional, SP2

Microsoft Windows 2000 Professional, SP4

he minimum hardware requirements for the client computer vary 
epending on the operating system you are running.

imum hardware requirements for Microsoft 
dows XP Professional

Minimum hardware requ
2000 Professional

Upgrading the RightFax
Because newer versions o
be compatible with older v
RightFax servers on your n
should be upgraded befor

To upgrade existing client 
client installation (page 45

Warning  In FaxUtil version
folders, which is not supporte
where users can switch betw
versions, any folders created
in earlier versions of the clien
versions of FaxUtil will not ap
created in earlier versions of 
and later in the All folder.

puter/Processor 233 MHz or higher Pentium-compatible CPU 
(300 MHz recommended)

ory 64 MB RAM (128 MB recommended)

d drive 1.5 GB

U support Up to two CPUs per computer

e CD-ROM or DVD drive

play VGA monitor running at a resolution of 800 × 
600 or higher

board/Mouse Required

Computer/Processor 133 MH

Memory 64 MB 

Hard drive 2 GB w

CPU support Up to tw

Drive CD-RO

Display VGA mo
600 or h

Keyboard/Mouse Require
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ce the RightFax Print Driver installation to use 
ript print driver, add the following section to the 

iring one of these printer drivers, all RightFax 
ust have network access to the HPFAX print 

tFax server.

l load time
or each user to load the FaxUtil client application 
 the number of RightFax users configured on the 
t FaxUtil is accessing. If the RightFax server 
mber of users, FaxUtil may be noticeably slow to 

ers configured on the RightFax server results in 
imes, you can create a registry entry on client 
ables the automatic loading of users when 
loading of user records will occur only if a user 
 FaxUtil that require it.

e loading of two types of user: administered 
cted users. 

ers are users that appear in a RightFax 
r group administrator’s FaxUtil mailbox.

rs are users who have the Unprotected mailbox 
 their user profiles. These users appear in all 
r lists as though they had delegated everyone 
m to access their fax mailboxes. 

istrators, disabling the loading of both 
nprotected may be necessary. For all other 
nly necessary to disable the loading of 

.

Before You Begin
By default, the RightFax client installation will use the first 
compatible printer driver it finds to create the RightFax Print Driver. 
If no compatible printer driver is found, RightFax will install one 
automatically. 

Note  If RightFax installs a printer driver automatically, this driver and its 
associated files will not be removed if RightFax is uninstalled. In a 
Microsoft Windows 2000 and XP Professional installation, the printer 
driver files reside at ..Windows\System32\Spool\Drivers\W32X86\3 and 
include the following:

� HPLJ5.BUD
� HPLJ5.GPD
� PCL5ERES.DLL
� STDNAMES.GPD
� TTFSUB.GPD
� UNIDRV.DLL
� UNIDRV.HLP
� UNIDRVUI.DLL
� UNIRES.DLL 

You can force the client installation to use a specific printer driver 
(if installed on the client computer) by modifying the file Setup.ini in 
the folder that contains the Setup.exe file (described in the next 
section). To specify a printer driver, edit the file Setup.ini with any 
text editor. Add a new section entitled [CmdLine]. Add a property 
to this section called PreferredDriver and set it to one of the 
following values.

For example, to for
the Adobe PostSc
Setup.ini file:

[CmdLine]
PreferredDriver=2

In addition to requ
client computers m
queue on the Righ

Decreasing FaxUti
The time required f
depends largely on
RightFax server tha
contains a large nu
load.

If the number of us
slow FaxUtil load t
computers that dis
FaxUtil is run. The 
performs actions in

You can disable th
users and unprote

� Administered us
administrator’s o

� Unprotected use
permission set in
other FaxUtil use
else to allow the

For RightFax admin
administered and u
FaxUtil users, it is o
unprotected users

Value Print driver

-1 Select automatically (default)

0 PCL-5

1 PCL-5E

2 Adobe PostScript
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plications

ll the client applications directly from the 
s method is recommended only if you 
htFax client installations.

client applications from the CD

puter and insert the RightFax server 
led, a menu of install options appears. If 
, browse the CD and run AutoRun.exe.

tions, select the option to install the 
 The RightFax install wizard opens.

ng screen to view the RightFax license 
ccept the license agreement in order to 
. Click Next.

ization name, and your product serial 
. Click Next.

een, select Typical Client and then click 

 screen you can remove or select 
tions you want to install. Enterprise Fax 
ightFax print driver, and the Microsoft 
for creating and sending faxes directly 
) are already selected. When you have 
ts to install, click Next.

ons screen, you will be prompted to 
ver Name. This option tells the client 
e the RightFax server by default. You can 
htFax servers to connect to within each 

e installation.
C

isable the loading of administered users

o disable the loading of administered users in FaxUtil on startup, 
lose FaxUtil and then add a REG_DWORD value called 
oadAdministeredUsers to HKEY_CURRENT_USER\
oftware\RightFAX Client\FUW32 and set the value data to 0 

zero).

isable the loading of unprotected users

o disable the loading of unprotected users in FaxUtil on startup, 
lose FaxUtil and then add a REG_DWORD value called 
oadUnprotectedUsers to HKEY_CURRENT_USER\Software
RightFAX Client\FUW32 and set the value data to 0 (zero).

utomatically disable user loading for new FaxUtil users

hese REG_DWORD values can also be applied for all new 
axUtil users on a particular computer. Modify the Windows 
egistry to add the REG_DWORD values described above to 
KEY_LOCAL_MACHINE\Software\RightFAX Client\FUW32. 
hen users run FaxUtil for the first time, they will be automatically 

onfigured to disable the loading of users.

ax Client Installation Methods
he RightFax client applications can be installed using any of the 
ollowing methods:

“Installing the Client Applications from the RightFax CD” 
(page 45)

“Installing the Client Applications from a Network File 
Share”(page 46)
“Creating an Automated Client Install” (page 46)

“Creating an Automated Client Uninstall” (page 48)

Installing the Client Ap
from the RightFax CD

Follow these steps to insta
RightFax software CD. Thi
have a small number of Rig

To install the RightFax 

1. Log on to the client com
CD. If AutoRun is enab
AutoRun is not enabled

2. In the menu of install op
RightFax product suite.

3. Click Next at the openi
agreement. You must a
continue the installation

4. Enter your name, organ
number when prompted

5. On the Setup Type scr
Next.

6. On the Custom Setup
additional client applica
Manager, FaxUtil, the R
Outlook fax extension (
from Microsoft Outlook
selected the componen

7. On the Advanced Opti
enter the RightFax Ser
software where to locat
also change or add Rig
client application.

Click Next.

8. Click Install to begin th
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ed Options screen, you will be prompted to 
Fax Server Name. This option tells the client 
 to locate the RightFax server by default. You 
e or add RightFax servers to connect to within 
lication.

begin the installation.

ated Client Install
quipped with Microsoft Systems Management 
Desk, or a similar network management system, 
the installation of RightFax client software using 
quivalent command. The RightFax client 
 uses Microsoft Windows Installer 

h, when run at a command prompt, can include 
 quiet install, output an SMS status .smf file, and 
rosoft documentation on the Msiexec.exe for 
n on running it with a command.

 RightFax client applications from a network file 
ptions are set in the installer settings file, 

located by default in the \Client folder on the file 
opy the client-only install.
Installing the Client Applications
from a Network File Share

You can install the RightFax client applications from a network file 
share by copying the Client folder from the RightFax Product Suite 
CD to a network file share and running setup. This installation, 
however, does not provide the ability to upgrade existing client 
applications. Existing clients you must be uninstalled prior to 
attempting an installation using this method. To perform a 
wide-scale removal of existing RightFax client applications, please 
see the section “Creating an Automated Client Uninstall”on 
page 48.

To install the RightFax client applications from the 
network file share

1. Copy the Client installation folder from the root of RightFax 
Product Suite CD to a network file share of your choosing.

2. Log on to the client computer and browse to the shared folder 
on your network that contains the RightFax client install and run 
setup.exe. The RightFax install wizard opens.

3. Click Next at the opening screen to view the RightFax license 
agreement. You must accept the license agreement in order to 
continue the installation. Click Next.

4. Enter your name and organization name when prompted. Click 
Next.

5. On the Setup Features screen, remove or select additional 
client applications you want to install. FaxUtil, the RightFax print 
driver, and the Microsoft Outlook fax extension (for creating and 
sending faxes directly from Microsoft Outlook) are already 
selected. If you are unsure of the available disk space, select 
the Space button to view a synopsis of what is disk space is 
available. When you have selected the components to install, 
click Next. 

6. On the Advanc
enter the Right
software where
can also chang
each client app

Click Next.

7. Click Install to 

Creating an Autom
If your network is e
Server (SMS), Lan
you can automate 
an SMS script or e
installation program
(Msiexec.exe) whic
switches to force a
more. Refer to Mic
detailed informatio

You must install the
share. Installation o
Setup.ini, which is 
server where you c
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Mod
T
I

T
y
I

ibe the command line options and 

d Line Options

Description

Controls what features are visible to 
the user.

� 1 = Clients with no EFM
� 2 = Clients with EFM
� 3 = All features available

Specify what language the RightFax 
clients will use. This is set to English 
by default.

> Specify the RightFax server the 
clients, IIS, or remote services will 
connect to. For clients, this sets the 
server the client will open when first 
installed. For IIS and remote services 
it is used to specify the server to 
connect to for configuration info or 
settings.
C

ifying the command line
o create the command line, edit the Setup.ini file with a text editor. 
n the [Startup] section, edit the CmdLine= command.

he following table describes the installation command switches 
ou can use. Refer to Microsoft documentation on the Windows 
nstaller for the latest information on these command line switches.

The following tables descr
properties you can use..

Switch Description

/qb Setup does not prompt the user for information. It 
does display progress indicators and a completion 
message at the end of the installation.

/qn Setup does not prompt the user for information. It 
does not display progress indicators as it installs. 
Does not display a completion message at the end 
of the installation

/qr Setup does not prompt the user for information. It 
does display a completion message at the end of the 
installation.

/qf Setup prompts the user for information. It does 
display progress indicators and a completion 
message at the end of the installation.

Table 4a  RightFax Advanced Comman

Property Parameters

INSTALLLEVEL 1|2|3

RFLANGUAGE <language>

RFSERVERNAME <servername
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ated Client Uninstall
quipped with Microsoft Systems Management 
Desk, or a similar network management system, 
the uninstallation of RightFax client software 
pt or equivalent command. The RightFax client 
 uses Microsoft Windows Installer 

h, when run at a command prompt, can include 

TRUE Set to “TRUE” to install the 
RightFax Print Driver 
feature.

TRUE Set to “TRUE” to install the 
FaxUtil feature.

TRUE Set to “TRUE” to install the 
RightFax Outlook Client 
feature.

TRUE Set to “TRUE” to install the 
MAPI Print Driver feature.

TRUE Set to “TRUE” to install the 
VIM Print Driver feature.

TRUE Set to “TRUE” to install the 
AutoReply Client feature.

TRUE Set to “TRUE” to install the 
Interaction Client feature.

TRUE Set to “TRUE” to install the 
Paperport Client feature.

TRUE Set to “TRUE” to install the 
Exchange 2000 MMC 
Client feature.

allation Properties (Continued)

Value Description
Creating an Autom
If your network is e
Server (SMS), Lan
you can automate 
using an SMS scri
installation program
(Msiexec.exe) whic

Table 4b  RightFax Client Installation Properties

Property Value Description

INSTALLDIR <install path>

Default: c:\program
files\rightfax\

Specify the path and the 
folder on the server where 
the RightFax software will 
be installed.

The value must end with a 
backslash (\).

SERIALNUM <serial number> Specify the product serial 
number.

This property is required for 
new installations.

If you are upgrading from an 
earlier version, this property 
is not required. You must 
delete this line or comment 
it from the properties text 
file so that it is not read by 
the installation program. If 
you keep this property in 
the properties text file 
without specifying the 
product serial number, then 
the serial number that is 
stored on your RightFax 
server will be deleted.

ALLUSERS 1 or 0 Specify “1” to install for all 
users on the system, “0” to 
have it install for only the 
current user. This value 
must be set to 1 for a server 
install.

INSTALL_EFM TRUE Set to “TRUE” to install the 
Enterprise Fax Manager 
feature.

INSTALL_FAXCTRL

INSTALL_FAXUTIL

INSTALL_OUTLOOK

INSTALL_MAPI
PRINTER

INSTALL_VIMPRINTER

INSTALL_AUTOREPLY
CLIENT

INSTALL_INTERACTION

INSTALL_PAPERPORT

INSTALL_EXCH2K
CLIENT

Table 4b  RightFax Client Inst

Property
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client using Windows 2000 or 2003 

 server using an account with 

duct Suite CD. Close the RightFax 
 is enabled.

r configured to use terminal services, go 
Add/Remove Programs.

rams.

y’ or floppy button and click Next.

tup.exe file and click Open followed by 

nt according to the instructions in the 
t Installation Methods” on page 45.

ient Installation

 most common error messages that may 
ightFax client applications with the 

ions.

Possible solutions

Verify that the RightFax Database module 
and RightFax RPC Server module 
services are running on the RightFax 
server.

Check the Networking program in 
Control Panel on the Windows NT server 
and verify that the protocols installed and 
enabled match those used by the clients.
C

witches to force a quiet install, output an SMS status .smf file, and 
ore. Refer to Microsoft documentation on the Msiexec.exe for 
etailed information on running it with a command.

ou must install the RightFax client applications from a network file 
hare. Installation options are set in the installer settings file, 
etup.ini, which is located by default in the \Client folder on the file 
erver where you copy the client-only install.

ifying the command line
. To create the command line, edit the Setup.ini file with a text 

editor. In the [Startup] section, edit the CmdLine= command.

. Remove all text following the CmdLine= entry.

. Add the command of: 

CmdLine=/qn Remove=All

. Save and close Setup.ini.

ou may now use your network management system software to 
emove the RightFax clients. The options you have just entered will 
ninstall the RightFax clients with no user interaction whatsoever 
nd will reboot all workstations (required). Upon restart, you may 
roceed with the automated install as outlined in the section 
Creating an Automated Client Install” on page 46.

uring Windows 2000 and 2003 Terminal 
es to Support RightFax Client Sessions
ightFax client applications can be installed on and run in multiple 
essions from a Windows 2000 or 2003 Server using terminal 
ervices. Running the RightFax client in the Windows terminal 
erver environment requires only one client install directly on the 
erver configured for terminal services, but supports an unlimited 
umber of simultaneous client sessions.

his installation also supports (but does not require) Citrix 
etaFrame.

To install the RightFax 
Terminal Services

1. Log on to the Windows
administrative access.

2. Insert the RightFax Pro
splash screen if autorun

3. On the Windows Serve
to the Control Panel > 

4. Choose Add New Prog

5. Select the ‘CD or Flopp

6. Browse to the Client\se
Next.

7. Install the RightFax clie
section “RightFax Clien

Troubleshooting the Cl
and Configuration

The following table lists the
appear after installing the R
probable causes and solut

Error or error 
message

The server is unavailable

The server is using 
different network 
protocols



RightFax 9.3 Installation Guide 50

ent 
le to 
server 

� Verify that the client and server 
machines can log on to a NetWare 
server. Verify that the SAP Agent is 
installed on the Windows NT server.

� Verify that the client and server are on 
the same network segment and that the 
router between the segments is 
configured to transport SAP type 
0×640 messages.

B Verify that the user logged in has access 
to the RightFax host file server. If the 
RightFax host file server is not a member, 
backup, or primary domain controller, 
then the user may not have access to the 
RightFax files or resource \PIPE\FAXDB. 
You may have to assign Guest privileges.

und in RightFax has its own list of fax users and 
the user ID specified is not on that list. 
You can use Enterprise Fax Manager to 
add users, either individually or by 
reading them from the domain or file 
server. When RightFax is first installed, 
the users “Administrator” and “Default” 
are loaded. Initially, neither user ID has a 
password.

plied You must use the correct password for 
the user specified. If the user has lost his 
password, a RightFax administrator can 
re-set the password in Enterprise Fax 
Manager.

Possible solutions
The common network 
protocol being used is 
not routed between LAN 
segments

� Try running a client on the same LAN 
segment as that of the server. Modify 
the appropriate bridge or routers to 
route the proper protocols.

� Update the server and clients to use a 
routed protocol.

� If the server machine has multiple 
network adapters installed, try 
removing all but one of the adapters 
and allow other routers on the network 
to route the packets.

The Windows NT server 
running RightFax is not 
configured to support 
NetWare clients

Verify that the Windows NT server is 
running gateway services for NetWare 
and the SAP Agent. Verify that the 
IPX/SPX transport is properly configured 
using the Network program in Windows 
Control Panel.

The NetWare clients are 
using different frame 
types than the Windows 
NT server

On the client computer, the frame type is 
in the Link Driver section of the 
NET.CFG. On the Windows NT server, 
the frame type is in the configuration of 
the NWLink IPX/SPX transport object in 
the Network program in Windows 
Control Panel. If the Windows NT server 
must support more than one frame type, 
ensure that the internal network number 
is a unique, non-zero number and that the 
Auto Frame Type Detection is disabled.

Error or error 
message Possible solutions

There is no SAP ag
computer accessib
both the client and 
machines

Unable to find FaxD
service

User ID was not fo
database

The password sup
is incorrect

Error or error 
message
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� � 

The RightFax fax 
addressing dialog box 
opens, but nothing 
appears in FaxUtil

� You are using a different user ID than 
expected. Check the RightFax Client 
program in Control Panel to see what 
user ID the software is using.

� On Windows NT, the port setting for 
the fax printer may be incorrect. 
Complete the Configure Fax Printers 
dialog box according to the instructions 
in “Configuring Windows 2000 and 
2003 Terminal Services to Support 
RightFax Client Sessions” on page 49.

Error or error 
message Possible solutions
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ager (see “Using Enterprise Fax 
and select the server you want to check.

the lower-right pane, double-click 
le. The RightFax Server Configuration 
Chapter 5 Upgrading and Adding Fax

er 5

rading and Adding Fax Channels, 
 Licenses, and Optional Components

ou can easily expand and extend the functionality of your RightFax 
erver by:

Upgrading the server (described on page 54)

Adding fax channels and user licenses (described on page 55)

Adding optional components (described on page 56)

ost of these additions to your fax server can be made without 
nstalling or re-installing software. You can add new functionality to 
ll RightFax servers using “bump codes.” Bump codes are special 
ctivation codes that enable specific functionality on the server. 
ump codes are provided by Captaris support engineers or your 
ightFax distributor, as described in this chapter.

ing for Installed Components
he different types of RightFax servers are installed with different 
umbers of licensed fax channels and users, and different optional 
omponents enabled. Follow these steps to display a list of the fax 
hannels, users, and components that have been enabled on the 
erver.

To check for installed c

1. Run Enterprise Fax Man
Manager” on page 32) 

2. In the list of services in 
RightFax Server Modu
window opens.
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htFax Server
servers can support small, medium, and large 
llowing servers are available.

es

tion

htFax server supports unlimited user accounts, It 
 one fax channel, and is expandable to 30 fax 
.

htFax server supports unlimited user accounts. It 
 three WorkServers and one fax channel, 
ble to support unlimited fax channels. This server 
 the RightFax Web Client™ and the OCR 
, OCR Converter™, Docs-on-Demand™, and 
nect™ modules.

rprise server is also available as a product suite 
des the RightFax Enterprise server, plus the 
 for Microsoft® Exchange, the Gateway for Lotus 

the Document Management Connector™, and the 
lerting™, and PDF modules.

tFax server and the RightFax Integration Module 
pplications for information exchange. The 
on Module integrates RightFax with applications 
rame, mid-range, and local area network host 
.

tFax Business Integration Module can be 
 on the RightFax Business and Enterprise servers.

tFax Enterprise Integration Module can be 
 on the RightFax Enterprise server.

htFax server supports up to 15 user accounts. It 
 two WorkServers and two fax channels.
3. Click the Feature Activation tab. The server type, number of 
licensed fax channels and users, and enabled components are 
listed in the window on this tab.

Figure 5.1  The List of Enabled RightFax Components

Upgrading the Rig
Captaris RightFax 
enterprises. The fo

Table 5a  RightFax Server Typ

RightFax 
server Descrip

Business server This Rig
includes
channels

Enterprise 
server

This Rig
includes
expanda
includes
Router™
TeleCon

The Ente
that inclu
Gateway
Notes®, 
SNMP A

Integration 
server

The Righ
enable a
Integrati
on mainf
systems

The Righ
installed

The Righ
installed

Satellite server This Rig
includes
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nd User Licenses

distributor and purchase the appropriate 
. You will be sent a new license card that 
 serial number.

ager (see “Using Enterprise Fax 
and select the server to which you are 
r licenses.

in the lower-right pane, double-click 
le. The RightFax Server Configuration 

ation tab.

ightFax service will be stopped, and a 
layed. Be prepared to provide this bump 
port engineer.

ct support group at (520) 320-7070.

Fax service plans require that you contact 
for bump codes rather than the RightFax 
must contact your distributor at the phone 
 as part of your service agreement.

elect the option for support with a 
, and then select the option for a bump 
outed to a support engineer.

provided by the support engineer for 
You will be provided with a new bump 
ture Activation tab.
Chapter 5 Upgrading and Adding Fax

o upgrade the RightFax server

. Contact your RightFax distributor and purchase the appropriate 
server license. You will be sent a new license card that includes 
a new product serial number. In some cases, you may also 
receive a new CD, which will require an additional installation as 
described in the product’s user guide.

. Run Enterprise Fax Manager (see “Using Enterprise Fax 
Manager” on page 32) and select the server that you want to 
upgrade.

. In the service name list in the lower-right pane, double-click 
RightFax Server Module. The RightFax Server Configuration 
window opens.

. Click the Feature Activation tab.

. In the Enter the System Identifier field, enter the RightFax 
system ID that was provided with your RightFax server software. 
Do not enter the product serial number, which is a separate 
identifier.

. Click Get Bump. The RightFax service will be stopped, and a 
bump code will be displayed. Be prepared to provide this bump 
code to a Captaris support engineer.

. Call the RightFax product support group at (520) 320-7070.

Important  Some RightFax service plans require that you contact 
your RightFax distributor for bump codes rather than the RightFax 
support group. If so, you must contact your distributor at the phone 
number that was provided as part of your service agreement.

. From the voice menu, select the option for support with a 
Captaris faxing product, and then select the option for a bump 
code. Your call will be routed to a support engineer.

. Follow the instructions provided by the support engineer for 
upgrading your server. You will be provided with a new bump 
code to enter in the Feature Activation tab.

Adding Fax Channels a

To add fax channels

1. Contact your RightFax 
channel or user license
includes a new product

2. Run Enterprise Fax Man
Manager” on page 32) 
adding channels or use

3. In the service name list 
RightFax Server Modu
window opens.

4. Click the Feature Activ

5. Click Get Bump. The R
bump code will be disp
code to a Captaris sup

6. Call the RightFax produ

Important  Some Right
your RightFax distributor 
support group. If so, you 
number that was provided

7. From the voice menu, s
Captaris faxing product
code. Your call will be r

8. Follow the instructions 
upgrading your server. 
code to enter in the Fea
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uctions provided by the support engineer for 
 server. You will be provided with a new bump 
 the Feature Activation tab.

the new bump code, the new RightFax 
ill be available. For information on configuring 

tFax components, refer to the documentation for 
roducts.

� � �
9. After you have added the new fax channels or user licenses, 
they must be configured for use by RightFax. New fax channels 
are configured in the BoardServer configuration program. New 
users are configured in Enterprise Fax Manager. For information 
on running the BoardServer configuration program or 
Enterprise Fax Manager, refer to the RightFax Administrator’s 
Guide.

Enabling New RightFax Optional Components

To enable new RightFax components

1. Contact your RightFax distributor and purchase the appropriate 
component license. You will be sent a new license card that 
includes a new product serial number.

2. Run Enterprise Fax Manager (described in the RightFax 
Administrator’s Guide) and select the server to which you are 
adding the new component.

3. In the service name list in the lower-right pane, double-click 
RightFax Server Module. The RightFax Server Configuration 
window opens.

4. Click the Feature Activation tab.

5. Click Get Bump. The RightFax service will be stopped, and a 
bump code will be displayed. Be prepared to provide this bump 
code to a Captaris support engineer.

6. Call the RightFax product support group at (520) 320-7070.

Important  Some RightFax service plans require that you contact 
your RightFax distributor for bump codes rather than the RightFax 
support group. If so, you must contact your distributor at the phone 
number that was provided as part of your service agreement.

7. From the voice menu, select the option for support with a 
Captaris faxing product, and then select the option for a bump 
code. Your call will be routed to a support engineer.

8. Follow the instr
upgrading your
code to enter in

9. After you enter 
component(s) w
and using Righ
your particular p
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he Microsoft Clustering Hardware 
d on the Microsoft Web site) that 
rds. 

erver 2000 or 2005 installation. 

rvice must be installed, configured, and 

ueing.

 using the Integration Module). 

unning either SCSI or fiber channel.

ating Systems

0 Advanced Server with SP4 installed

0 Datacenter Server with SP4 installed
Chapter 6 Installing Rig

er 6

alling RightFax in a Windows 2000
indows 2003 Cluster

aution  Because the RightFax server software architecture is not fully 
luster-aware with replayable transaction logs, some in-process data may 
e lost during a cluster failover. If failover occurs, faxes that were 

n-process may fail conversion, may have fax conversion delayed, or may 
e lost and unrecoverable.

ring RightFax with Microsoft 
ws 2000 Server
his section outlines how to install RightFax on an existing 
icrosoft Windows 2000 Server cluster. This is not meant as a 
eneral guide on clustering concepts, configuration, operation, or 
upport. It is recommended that you become familiar with 
lustering concepts and the Windows 2000 Cluster Service prior 
o beginning this procedure.

o view documentation on “Clustering RightFax with Microsoft 
indows 2003 Server”, see page 65.

System requirements
Installing RightFax in a Win
requires the following com

� Two servers that are on t
Compatibility List (locate
possess two network ca

� A local or remote SQL S

� The Windows Cluster Se
operational. 

� Windows Message Que

� Print services for Unix (if
� MDAC 2.8 or higher.

� An external RAID array r

Supported Windows Oper

� Microsoft Windows 200

� Microsoft Windows 200
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e or disk device failure, it will not affect 
rformance, and it is a good choice when 
s are limited to a single logical drive.

 these instructions, the name 'RightFax group' 
ignate the group where RightFax services are to 

Server is installed on the same cluster, it is 
he RightFax resources be added to the same cluster 
s the SQL instance to be used. This will allow a 
reated which will prevent the RightFax services from 
 the SQL instance is unavailable. 

ered print spooler

dministrator.

rint spooler resource in the RightFax group. 

ory on the shared drive called <drive:>\SPOOL.

esources, then click New > Resource.

rce wizard will appear. In the name box, type the 
ource (such as RightFax Print Spooler). The 
 be the same as the resource name.

Type should be Print Spooler.

 Owners box, verify the presence of all nodes.

e Dependencies box, add the disk and network 
s.

ters tab, type the path to the Spool directory on 
.

add the resource to the group.

/IP Print Server service. (This step is required 
Fax Integration Module is to be installed.)
SQL Server requirements

� When using a RightFax cluster, all versions of SQL Server must 
be set to Mixed Mode, with SQL authentication enabled.

� SQL Server Standard Edition cannot be installed on the RightFax 
cluster.

� SQL Server Enterprise Edition can be used on either a separate 
hardware platform or as a clustered instance on the same 
platform that will host RightFax. 

Note   For the purpose of the these instructions, the name “RightFax 
group” will be used to designate the group where the RightFax services 
are to be created, regardless of the actual group chosen. “Cluster IP 
address” and “cluster name” will be used to designate the IP address 
and name of the virtual server used (the IP address and server name 
resources contained within the RightFax group).

Configuring RightFax BoardServers
It is strongly recommended that no RightFax BoardServers be 
installed on the clustered hardware. Phone lines and T1 lines 
cannot be clustered and will not failover in the event of a hardware 
problem. Captaris recommends that you use remote BoardServers, 
connecting to the virtual RightFax server.

Configuring the Cluster Group
All of the clustered RightFax resources must be maintained in a 
single cluster group. This provides complete failover protection in 
the event of individual resource failures. This cluster group must 
also include a disk resource, a server name resource, and an IP 
address resource. The combination of these core resources 
creates a virtual RightFax server. Configure the cluster group to 
have a preferred server and to allow fail-back.

The default group created during the Cluster service installation, 
named “Cluster Group,” may also be used for the RightFax 
resources. In this case, the quorum drive is typically used as the 
shared installation drive for the RightFax software. While this 
approach may add complexity to recovery procedures in the event 

of a Cluster servic
configuration or pe
hardware resource

For the purpose of
will be used to des
be created

Important  If SQL 
recommended that t
group which contain
dependency to be c
attempting to start if

To create a clust

1. Open Cluster A

2. Create a new p

3. Create a direct

4. Right click on R

5. The New Resou
name of the res
description can

6. The Resource 

7. In the Possible

8. In the Resourc
name resource

9. On the Parame
the shared drive

10.Click Finish to 

11.Cluster the TCP
only if the Right
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ch cluster node
e has control of the RightFax group, 
ive to which RightFax will be installed.

n the RightFax 9.3 Prerequisites Setup 
tions in Chapter 3, “Running the 

Be sure to provide the network name of 
L Server instance (if used) or the name 
r.

stall the RightFax server software to the 
 to the instructions in Chapter 3, 

 Server Software” and the additional 
elow.

ervice account that is a domain member 
l nodes (local accounts cannot be used). 

t the computer at the end of the 
. 

 board hardware drivers. 

rvices management console and stop all 
es. Set all of the RightFax services to 
get the Captaris Conversion Engine.

rol panel on the primary node and stop 
ter.

ator, move the RightFax group to the 
the resources to come back online.

ax directory from the shared drive.

econd node, selecting the same options 
llation. Remember to change the 
he shared drive, not the default of 
ax.

 overwrite the existing database or add 
overwrite.
Chapter 6 Installing Rig

2.Set the TCP/IP Print Server service (Print Services for Unix) to 
manual startup on each node. Stop the services if currently 
running.

3.Create a new Generic Service resource. Enter LPDSVC as the 
service name.

4.From the properties dialog of the new service, select the print 
spooler resource as a dependency.

o create cluster resources for required networking 
ervices

. Create a new Distributed Transaction Coordinator resource in 
the RightFax group. This is done with the Comclust.exe utility 
installed with the Windows 2000 Cluster Service. The MSDTC 
resource must reside in the RightFax group. See Microsoft 
documentation for more information on adding and configuring 
the MSDTC service in a cluster.

. Create a new Message Queuing resource in the RightFax 
group. Make it dependent on the disk and network name 
resources.

. Bring all resources online.

o verify failover and failback

. Open Cluster Administrator on the second node.

. Verify that the primary node currently owns all resources, and 
that they are online.

. Shut down the primary node and verify that all resources fail 
over to the secondary node.

. Restart the primary node and verify that all resources fail back.

Installing RightFax on ea
1. Ensure the primary nod

including the shared dr

2. On the primary node, ru
according to the instruc
Prerequisites Wizard”. 
either the clustered SQ
of a remote SQL Serve

3. On the primary node, in
shared drive according
“Installing the RightFax
requirements outlined b

� Use a WorkServer s
and has access to al

� If prompted to restar
installation, select No

� Do not install the fax

4. Open the Windows Se
running RightFax servic
manual start. Do not for

5. Open the Printers cont
sharing the HPFAX prin

6. From Cluster Administr
second node. Wait for 

7. Delete the entire RightF

8. Install RightFax on the s
as during the first insta
installation location to t
C:\ProgramFiles\RightF

9. When asked whether to
a new instance, select 
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Fax Cluster Resources
tFax cluster resources, run Cluster Administrator 
tFax cluster group. You will create the following 

 share resource

ources, and then select New > Resource. The 
rce wizard opens.

d Description boxes, enter “RightFax File 

Type to File Share.

tFax group.

 Owners box, enter the names of both nodes in 
electing them and clicking Add.

e Dependencies box, add the Disk Resource, 
, and IP Address resources.

luster Resources

e Type of Resource Service Name

File Share N/A

n Engine Generic Service RFIsoConv

port Generic Service RFDocTrans

odule Generic Service RFServer

andler Generic Service RFqueue

ver Module Generic Service RFRPC

 Service Generic Service RFremote

odule Generic Service RFpage

teway Generic Service RFEmail
10.Set all of the RightFax services to manual start, and stop any 
that are running.

11.Open the Printers control panel on the secondary node and 
stop sharing the HPFAX printer.

To create the HPFAX print queue

1. Open the Printer folder on the RightFax virtual server by typing 
\\<cluster_name> from the Windows Run dialog found on the 
Start menu. In Windows Explorer, open the Printers control 
panel (folder). 

2. Create a new TCP/IP port, using the shared cluster IP address 
as the target IP address and HPFAX as the port name.

3. Select Custom Device Type, and click Settings. Select RAW 
as the protocol and set the port number to 53199.

4. Select an HP LaserJet III, LaserJet 4, or LaserJet 5 printer driver 
and share the printer as HPFAX.

5. Open the Properties of the HPFAX printer, click the Advanced 
tab, and then click Separator Page. Enter the following for the 
separator page:

SharedDrive:\RightFax\bin\RightFax.sep

Where SharedDrive is the drive letter of the shared drive on 
which RightFax is installed.

6. Re-start both nodes. Once restarted, the primary node should 
have control of the RightFax group, including the shared drive. 

7. Use Cluster Administrator to move the group to the node which 
was installed LAST.

Creating the Right
To create the Righ
and open the Righ
resources.

To create the file

1. Right-click Res
Generic Resou

2. In the Name an
Share.”

3. Set Resource 

4. Select the Righ

5. In the Possible
the cluster by s

6. In the Resourc
Network Name

Table 6a  RightFax C

Name of Resourc

RightFax File Share

Captaris Conversio

RightFax DocTrans

RightFax Server M

RightFax Queue H

RightFax RPC Ser

RightFax Remoting

RightFax Paging M

RightFax E-mail Ga
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onversion Engine resource

 and then select New > Resource. The 
rd opens.

ription boxes, enter “Captaris 

Generic Service.

up.

s box, enter the names of both nodes in 
 them and clicking Add.

dencies box, add the RightFax file 
File Share”. 

 Parameters box, type “RFISOCONV”. 
network name for computer name” 

 resource to the group.

ort Module resource

 and then select New > Resource. The 
rd opens.

ription boxes, enter “RightFax 

Generic Service.

up.

s box, enter the names of both nodes in 
 them and clicking Add.

dencies box, add the RightFax RPC 

 Parameters box, type 
ot select the “use network name for 
box.
Chapter 6 Installing Rig

. In the Generic File Share Parameters box, enter the path to 
the RightFax directory on the shared drive. Be sure to use 
RightFax as the share name.

. On the Parameters tab, click the Permissions button. Give 
“Everyone” both read and change permissions.

. Click Finish to add the resource to the group

0.Bring the resource online.

o create the RightFax RPC Server Module resource.

. Right-click Resources, and then select New > Resource. The 
Generic Resource wizard opens.

. In the Name and Description boxes, enter “RightFax RPC 
Server Module.”

. Set Resource Type to Generic Service.

. Select the RightFax group.

. In the Possible Owners box, enter the names of both nodes in 
the cluster by selecting them and clicking Add.

. In the Resource Dependencies box, add the RightFax file 
share name- “RightFax File Share” and the SQL server name (if 
present).

. In the Generic Service Parameters box, type “RFRPC.” Do not 
select the “use network name for communications.”

. Under Registry Replication, click Add and type 
“SOFTWARE\RightFax.” This allows the registry information 
stored by RightFax to dynamically change from one node to 
another if the server goes down.

. Click Finish to add the resource to the group.

To create the Captaris C

1. Right-click Resources,
Generic Resource wiza

2. In the Name and Desc
Conversion Engine”.

3. Set Resource Type to 

4. Select the RightFax gro

5. In the Possible Owner
the cluster by selecting

6. In the Resource Depen
share name- “RightFax 

7. In the Generic Service
Do not select the “use 
checkbox.

8. Click Finish to add the

To create the DocTransp

1. Right-click Resources,
Generic Resource wiza

2. In the Name and Desc
DocTransport Module”.

3. Set Resource Type to 

4. Select the RightFax gro

5. In the Possible Owner
the cluster by selecting

6. In the Resource Depen
Module (RFRPC). 

7. In the Generic Service
“RFDOCTRANS”. Do n
computer name” check
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Service Parameters box, type “RFQUEUE.” Do 
use network name for computer name” 

add the resource to the group.

htFax Remoting Service resource

ources, and then select New > Resource. The 
rce wizard opens.

d Description boxes, enter “RightFax Remoting 

Type to Generic Service.

tFax group.

 Owners box, enter the names of both nodes in 
electing them and clicking Add.

e Dependencies box, add the RightFax file 
ightFax File Share”. 

Service Parameters box, type “RFREMOTE”. 
e “use network name for computer name” 

add the resource to the group.

htFax Paging Module resource

ources, and then select New > Resource. The 
rce wizard opens.

e and Description boxes, enter “RightFax 
.”

Type to Generic Service.

tFax group.

 Owners box, enter the names of both nodes in 
electing them and clicking Add.
8. Click Finish to add the resource to the group.

To create the RightFax Server Module resource

1. Right-click Resources, and then select New > Resource. The 
Generic Resource wizard opens.

2. In the Name and Description boxes, enter “RightFax Server 
Module.”

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in 
the cluster by selecting them and clicking Add.

6. In the Resource Dependencies box, add the RightFax RPC 
Module (RFRPC). 

7. In the Generic Service Parameters box, type “RFSERVER.” 
Do not select the “use network name for computer name” 
checkbox.

8. Click Finish to add the resource to the group.

To create the RightFax Queue Handler resource

1. Right-click Resources, and then select New > Resource. The 
Generic Resource wizard opens.

2. In the Name and Description boxes, enter “RightFax Queue 
Handler.”

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in 
the cluster by selecting them and clicking Add.

6. In the Resource Dependencies box, add the RightFax file 
share name- “RightFax File Share”. 

7. In the Generic 
not select the “
checkbox.

8. Click Finish to 

To create the Rig

1. Right-click Res
Generic Resou

2. In the Name an
Service”.

3. Set Resource 

4. Select the Righ

5. In the Possible
the cluster by s

6. In the Resourc
share name- “R

7. In the Generic 
Do not select th
checkbox.

8. Click Finish to 

To create the Rig

1. Right-click Res
Generic Resou

2. In both the Nam
Paging Module

3. Set Resource 

4. Select the Righ

5. In the Possible
the cluster by s
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 contacting the RightFax product 
320-7070. A support engineer will assist 
tion process.

ne after successfully licensing your 

 installation

x resources on-line.

nership of the RightFax group, open 

TWARE\RightFax\Install\. Change the 
o reflect the shared network name of the 
 name of the node.

ARE\RightFax\Production\. Change the 
me to the shared network name of the 

TWARE\RightFax\Production\Servers. 
key with the same name as the node. 
the shared network name of the 

ator, verify that the RightFax group can 
line without errors. 

n the nodes, verifying that all the 
y on each node. Correct any issues 
g. 

 resources are online. Install remote 
ed, pointing them to the shared network 
luster group, rather than the name of any 

rompted during remote BoardServer 
ption to use an existing SQL Server, and 
er name (clustered instance name if 
formation
Chapter 6 Installing Rig

. In the Resource Dependencies box, add the RightFax file 
share name- “RightFax File Share”. 

. In the Generic Service Parameters box, type “RFPAGE.” Do 
not select the “use network name for computer name” 
checkbox.

. Click Finish to add the resource to the group.

o create the RightFax E-mail Gateway resource (if 
nstalled)

. Right-click Resources, and then select New > Resource. The 
Generic Resource wizard opens.

. In both the Name and Description boxes, enter “RightFax 
E-mail Gateway.”

. Set Resource Type to Generic Service.

. Select the RightFax group.

. In the Possible Owners box, enter the names of both nodes in 
the cluster by selecting them and clicking Add.

. In the Resource Dependencies box, add the RightFax Server 
resource “RFSERVER”.

. In the Generic Service Parameters box, type “RFEMAIL.” Do 
not select the “use network name for computer name” 
checkbox.

. Click Finish to add the resource to the group.

o license your cluster

. Take the RightFax service resources offline. Do not take the 
entire group offline.

arning  All RightFax services must be taken offline using Cluster 
dministrator. Failure to do so will result in an immediate failover.

. From the node with ownership of the RightFax resources, open 
the Server Module applet located in Windows control panel.

3. License your cluster by
support group at (520) 
you through the registra

4. Bring all resources onli
cluster.

To complete the cluster

1. Bring all of the RightFa

2. From the node with ow
Regedit.

3. Browse to HKLM\SOF
value RFServerName t
RightFax group, not the

4. Browse HKLM\SOFTW
value RightFaxServerNa
RightFax group.

5. Browse to HKLM\SOF
Here you will find a sub
Rename this subkey to 
RightFax group.

6. From Cluster Administr
be taken offline and on

7. Move the group betwee
resources start correctl
found before proceedin

8. Make sure the RightFax
BoardServers as requir
name of the RightFax c
individual node. When p
installation, select the o
supply the correct serv
applicable) and logon in
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ter inputs are needed, create them in the same 
/IP ports.  Named pipes will not function in the 

ent.

se the applet and create the service.

ightFax Integration Module service is set to 

 to the second node.

ration applet on the second node. All 
ttings should be retained. Click OK to close the 
te the service.

ightFax Integration Module service is set to 

neric Service resource in the RightFax 

ources, and then select New > Resource. The 
rce wizard opens.

e and Description boxes, enter “RightFax 
ule.”

Type to Generic Service.

tFax group.

 Owners box, enter the names of both nodes in 
electing them and clicking Add.

e Dependencies box, add the RightFax Server 
ERVER”.

Service Parameters box, type “RFPROD.” Do 
use network name for computer name” 

add the resource to the group.

esource online.

nd failback is successful.
Configuring the Integration Module in a Windows 2000 
Cluster

Follow the instructions below if licensed for the Integration Module.

1. From the active node, open the RightFax Integration applet from 
the Windows Control Panel. 

Note  If the Integration applet does not appear in the Control Panel, 
locate the Shared Files folder under the RightFax Directory, and open 
rfprod_ctl.cpl to launch the applet.

2. Run the Integration Wizard or manually configure the Integration 
Module. Do not close the applet.

Important  Change the RightFax Server name to the shared 
network name of the RightFax group.

3. Open the Windows registry and browse to the subkey: 
HKLM\SOFTWARE\RightFax\Production\RFProd.

4. Modify the command line for the three default printer inputs so 
that they use TCP/IP ports rather than named pipes by using 
the table below. The numbers at the end of the new command 
lines are the TCP/IP port numbers. You can select any port 
number that is not in use on either node of the cluster. 
Alternatively, you may delete and recreate existing inputs, 
however, you must set the new inputs to the type of "TCP/IP 
Port"

5. If additional prin
way using TCP
cluster environm

6. Click OK to clo

7. Verify that the R
manual start.

8. Move the group

9. Open the Integ
configuration se
applet and crea

10.Verify that the R
manual start.

Create a new Ge
group

1. Right-click Res
Generic Resou

2. In both the Nam
Integration Mod

3. Set Resource 

4. Select the Righ

5. In the Possible
the cluster by s

6. In the Resourc
resource “RFS

7. In the Generic 
not select the “
checkbox.

8. Click Finish to 

9. Bring the new r

10.Verify failover a

Table 6b  

Printer 
Name

Default Command 
Line

Required Command 
Line

HostFax nplisten -c "makedoc 
$$" -p hflpr

portlstn -c "makedoc $$" 
-p 8201

PCL nplisten -c "pfilter $$ | 
makedoc" -p hfpcl

portlstn -c "pfilter $$ | 
makedoc" -p 8202

Postscript nplisten -c "pfilter -p $$ | 
makedoc" -p hfps

portlstn -c "pfilter -p $$ | 
makedoc" -p 8203
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r Hot Fixes
 RightFax service pack or hot-fix after the 
as been completed, follow these steps:

tor and stop all RightFax services. Do 
le share offline.

 active node according to the 
ith the update.

ing the RightFax services to the next 
hem online.

 new node according to the instructions 
te.

 remote BoardServers and 
ble.

ator, bring the RightFax services back 

h Microsoft

o install RightFax 9.3 on an existing 
Server cluster. This is not meant as a 
 concepts, configuration, operation, or 

d that you become familiar with 
e Windows 2003 Cluster Service prior 
e.
Chapter 6 Installing Rig

onfigure the Integration Module Printers

. Click Start > Run, and enter \\<cluster_name>.

. In Windows Explorer, open the Printers folder

Important  You must open the cluster printer folder belonging to the 
virtual machine, not the printer folder belonging to either node. If you 
access the printers in the usual way from Start, Settings, Printers, you 
are only opening the node's printer folder.

. Create new ports for each of the printer inputs defined in the 
Integration applet.

. Create a new printer port of the "Standard TCP/IP Port" type. 

. Use the shared cluster IP address as the target IP address, and 
HostFax as the port name. 

. Select "Custom" device type, click settings, and specify "RAW" 
as the protocol, and the TCP/IP port number specified in the 
Portlstn command line from the Production applet (8201 in the 
example from the earlier step).

. Repeat to create new printer ports for each of the other default 
printer inputs, using HFPCL and HFPS as the port names, and 
the TCP/IP port numbers specified in the applet.  Also create 
ports for any custom printer inputs to be used.

. Create new printers for each Integration print queue. Use the 
printer names HostFax, HFPCL, and HFPS, and the previously 
created ports.

Important  Use only Generic, Plain Text as the printer driver for every 
Integration Module print queue

sing FTP with the Integration Module

f FTP is to be used for the Integration Module, add a virtual 
irectory to BOTH nodes using IIS Manager, with the local path 
eing the \RightFax\Production\Inbox directory on the shared drive. 

t is not necessary to cluster the FTP service.

Applying Service Packs o
If it is necessary to apply a
installation on the cluster h

1. Run Cluster Administra
not take the RightFax fi

2. Apply the update to the
instructions provided w

3. Move the group contain
node without bringing t

4. Apply the update to the
provided with the upda

5. Apply the update to any
WorkServers, if applica

6. From Cluster Administr
online.

Clustering RightFax wit
Windows 2003 Server

This section outlines how t
Microsoft Windows 2003 
general guide on clustering
support. It is recommende
clustering concepts and th
to beginning this procedur
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ax BoardServers
mended that no RightFax BoardServers be 
stered hardware. Phone lines and T1 lines 
d and will not failover in the event of a hardware 
recommends that you use remote BoardServers, 
virtual RightFax server.

uster Group
 RightFax resources must be maintained in a 
p. This provides complete failover protection in 
ual resource failures. This cluster group must 
 resource, a server name resource, and an IP 
The combination of these core resources 
ghtFax server. Configure the cluster group to 
rver and to allow fail-back.

created during the Cluster service installation, 
roup,” may also be used for the RightFax 
ase, the quorum drive is typically used as the 
drive for the RightFax software. While this 
 complexity to recovery procedures in the event 
e or disk device failure, it will not affect 
rformance, and it is a good choice when 
s are limited to a single RAID controller.

 these instructions, the name 'RightFax group' 
ignate the group where RightFax services are to 

Server is installed on the same cluster, it is 
he RightFax resources be added to the same cluster 
s the SQL instance to be used. This will allow a 
reated which will prevent the RightFax services from 
 the SQL instance is unavailable. 
System requirements
Installing RightFax in a Windows Server 2003 cluster environment 
requires the following components.

� Two servers that are on the Microsoft Clustering Hardware 
Compatibility List (located on the Microsoft Web site) that 
possess two network cards. 

� A local or remote SQL Server 2000 or 2005 installation. 

� The Windows Cluster Service must be installed, configured, and 
operational. 

� Windows Application server component with Network 
Distributed Transaction Coordinator and Message Queuing 
installed.

� Print services for Unix (if using the Integration n Module). 

� MDAC 2.8 or higher.

An external RAID array running either SCSI or fiber channel.

Supported Windows Operating Systems

� Microsoft Windows Server 2003 Enterprise Edition
� Microsoft Windows Server 2003 Datacenter Edition

SQL Server requirements

� When using a RightFax cluster, all versions of SQL Server must 
be set to Mixed Mode, with SQL authentication enabled.

� SQL Server Standard Edition cannot be installed on the RightFax 
cluster.

� SQL Server Enterprise Edition can be used on either a separate 
hardware platform or as a clustered instance on the same 
platform that will host RightFax. 

Configuring RightF
It is strongly recom
installed on the clu
cannot be clustere
problem. Captaris 
connecting to the 

Configuring the Cl
All of the clustered
single cluster grou
the event of individ
also include a disk
address resource. 
creates a virtual Ri
have a preferred se

The default group 
named “Cluster G
resources. In this c
shared installation 
approach may add
of a Cluster servic
configuration or pe
hardware resource

For the purpose of
will be used to des
be created.

Important  If SQL 
recommended that t
group which contain
dependency to be c
attempting to start if
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ces for required networking 

ator, take the network name resource in 
ne.

e network name resource. Click the 
lect “Enable Kerberos Authentication” 

 resource back online.

d Transaction Coordinator resource in 
ke it dependent on the disk and network 
icrosoft documentation for more 
nd configuring the MSDTC service in a 

.

 Queuing resource in the RightFax 
nt on the disk and network name 

ne.

ilback

rator on the second node.

ode currently owns all resources, and 

node and verify that all resources fail 
ode.

e and verify that all resources fail back.
Chapter 6 Installing Rig

o create a clustered print spooler

. Open Cluster Administrator.

. Create a new print spooler resource in the RightFax group. 

. Create a directory on the shared drive called <drive:>\SPOOL.

. Right click on Resources, then click New > Resource.

. The New Resource wizard will appear. In the name box, type the 
name of the resource (such as RightFax Print Spooler). The 
description can be the same as the resource name.

. The Resource Type should be Print Spooler.

. In the Possible Owners box, verify the presence of all nodes.

. In the Resource Dependencies box, add the disk and network 
name resources.

. On the Parameters tab, type the path to the Spool directory on 
the shared drive.

0.Click Finish to add the resource to the group.

1.Cluster the TCP/IP Print Server service. (This step is required 
only if the RightFax Integration Module is to be installed.)

2.Set the TCP/IP Print Server service (Print Services for Unix) to 
manual startup on each node. Stop the services if currently 
running.

3.Create a new Generic Service resource. Enter LPDSVC as the 
service name.

4.From the properties dialog of the new service, select the print 
spooler resource as a dependency.

To create cluster resour
services

1. From Cluster Administr
the RightFax group offli

2. Edit the properties of th
Parameters tab and se
and click OK.

3. Bring the network name

4. Create a new Distribute
the RightFax group. Ma
name resources. See M
information on adding a
Windows 2003 cluster

5. Create a new Message
group. Make it depende
resources.

6. Bring all resources onli

To verify failover and fa

1. Open Cluster Administ

2. Verify that the primary n
that they are online.

3. Shut down the primary 
over to the secondary n

4. Restart the primary nod
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ghtFax services to manual start, and stop any 
.

rs control panel on the secondary node and 
e HPFAX printer.

FAX print queue

r folder on the RightFax virtual server by typing 
e> from the Windows Run dialog found on the 

indows Explorer, open the Printers control 

CP/IP port, using the shared cluster IP address 
 address and HPFAX as the port name.

 Device Type, and click Settings. Select RAW 
 and set the port number to 53199.

aserJet III, LaserJet 4, or LaserJet 5 printer driver 
rinter as HPFAX.

erties of the HPFAX printer, click the Advanced 
lick Separator Page. Enter the following for the 
:

rive:\RightFax\bin\RightFax.sep

rive is the drive letter of the shared drive on 
 is installed.

odes. Once restarted, the primary node should 
the RightFax group, including the shared drive. 

ministrator to move the group to the node which 
AST.
Installing RightFax on each cluster node
1. Ensure the primary node has control of the RightFax group, 

including the shared drive to which RightFax will be installed.

2. On the primary node, run the RightFax 9.3 Prerequisites Setup 
according to the instructions in Chapter 3, “Running the 
Prerequisites Wizard”. Be sure to provide the network name of 
either the clustered SQL Server instance (if used) or the name 
of a remote SQL Server.

3. On the primary node, install the RightFax server software to the 
shared drive according to the instructions in Chapter 3, 
“Installing the RightFax Server Software” and the additional 
requirements outlined below.

� Use a WorkServer service account that is a domain member 
and has access to all nodes (local accounts cannot be used). 

� If prompted to restart the computer at the end of the 
installation, select No. 

� Do not install the fax board hardware drivers. 

4. Open the Windows Services management console and stop all 
running RightFax services. Set all of the RightFax services to 
manual start. Do not forget the Captaris Conversion Engine.

5. Open the Printers control panel on the primary node and stop 
sharing the HPFAX printer.

6. From Cluster Administrator, move the RightFax group to the 
second node. Wait for the resources to come back online.

7. Delete the entire RightFax directory from the shared drive.

8. Install RightFax on the second node, selecting the same options 
as during the first installation. Remember to change the 
installation location to the shared drive, not the default of 
C:\ProgramFiles\RightFax.

9. When asked whether to overwrite the existing database or add 
a new instance, select overwrite.

10.Set all of the Ri
that are running

11.Open the Printe
stop sharing th

To create the HP

1. Open the Printe
\\<cluster_nam
Start menu. In W
panel (folder).

2. Create a new T
as the target IP

3. Select Custom
as the protocol

4. Select an HP L
and share the p

5. Open the Prop
tab, and then c
separator page

SharedD

Where SharedD
which RightFax

6. Re-start both n
have control of 

7. Use Cluster Ad
was installed L
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re Parameters box, enter the path to 
n the shared drive. Be sure to use 
ame.

, click the Permissions button. Give 
nd change permissions.

 resource to the group

e.

RPC Server Module resource

 and then select New > Resource. The 
rd opens.

ription boxes, enter “RightFax RPC 

Generic Service.

up.

s box, enter the names of both nodes in 
 them and clicking Add.

dencies box, add the RightFax file 
File Share” and the SQL server name (if 

 Parameters box, type “RFRPC.” Do not 
 name for communications.”

tion, click Add and type 
.” This allows the registry information 
ynamically change from one node to 
es down.

 resource to the group.

T
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ating the RightFax Cluster Resources
o create the RightFax cluster resources, run Cluster Administrator 
nd open the RightFax cluster group. You will create the following 
esources.

o create the File Share resource

. Right-click Resources, and then select New > Resource. The 
Generic Resource wizard opens.

. In the Name and Description boxes, enter “RightFax File 
Share.”

. Set Resource Type to File Share.

. Select the RightFax group.

. In the Possible Owners box, enter the names of both nodes in 
the cluster by selecting them and clicking Add.

. In the Resource Dependencies box, add the Disk Resource, 
Network Name, and IP Address resources.

7. In the Generic File Sha
the RightFax directory o
RightFax as the share n

8. On the Parameters tab
“Everyone” both read a

9. Click Finish to add the

10.Bring the resource onlin

To create the RightFax 

1. Right-click Resources,
Generic Resource wiza

2. In the Name and Desc
Server Module.”

3. Set Resource Type to 

4. Select the RightFax gro

5. In the Possible Owner
the cluster by selecting

6. In the Resource Depen
share name- “RightFax 
present).

7. In the Generic Service
select the “use network

8. Under Registry Replica
“SOFTWARE\RightFax
stored by RightFax to d
another if the server go

9. Click Finish to add the

able 6c  RightFax Cluster Resources

Name of Resource Type of Resource Service Name

RightFax File Share File Share N/A

Captaris Conversion Engine Generic Service RFIsoConv

RightFax DocTransport Generic Service RFDocTrans

RightFax Server Module Generic Service RFServer

RightFax Queue Handler Generic Service RFqueue

RightFax RPC Server Module Generic Service RFRPC

RightFax Remoting Service Generic Service RFremote

RightFax Paging Module Generic Service RFpage

RightFax E-mail Gateway Generic Service RFEmail
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add the resource to the group.

htFax Server Module resource

ources, and then select New > Resource. The 
rce wizard opens.

d Description boxes, enter “RightFax Server 

Type to Generic Service.

tFax group.

 Owners box, enter the names of both nodes in 
electing them and clicking Add.

e Dependencies box, add the RightFax RPC 
C.exe). 

Service Parameters box, type “RFSERVER.” 
e “use network name for computer name” 

add the resource to the group.

htFax Queue Handler resource

ources, and then select New > Resource. The 
rce wizard opens.

d Description boxes, enter “RightFax Queue 

Type to Generic Service.

tFax group.

 Owners box, enter the names of both nodes in 
electing them and clicking Add.

e Dependencies box, add the RightFax file 
ightFax File Share”. 
To create the Captaris Conversion Engine resource

1. Right-click Resources, and then select New > Resource. The 
Generic Resource wizard opens.

2. In the Name and Description boxes, enter “Captaris 
Conversion Engine”.

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in 
the cluster by selecting them and clicking Add.

6. In the Resource Dependencies box, add the RightFax file 
share name- “RightFax File Share”. 

7. In the Generic Service Parameters box, type “RFISOCONV”. 
Do not select the “use network name for computer name” 
checkbox.

8. Click Finish to add the resource to the group.

To create the DocTransport Module resource

1. Right-click Resources, and then select New > Resource. The 
Generic Resource wizard opens.

2. In the Name and Description boxes, enter “RightFax 
DocTransport Module”.

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in 
the cluster by selecting them and clicking Add.

6. In the Resource Dependencies box, add the RightFax RPC 
Module (RFRPC). 

7. In the Generic Service Parameters box, type 
“RFDOCTRANS”. Do not select the “use network name for 
computer name” checkbox.

8. Click Finish to 

To create the Rig

1. Right-click Res
Generic Resou

2. In the Name an
Module.”

3. Set Resource 

4. Select the Righ

5. In the Possible
the cluster by s

6. In the Resourc
Module (RFRP

7. In the Generic 
Do not select th
checkbox.

8. Click Finish to 

To create the Rig

1. Right-click Res
Generic Resou

2. In the Name an
Handler.”

3. Set Resource 

4. Select the Righ

5. In the Possible
the cluster by s

6. In the Resourc
share name- “R
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File Share”. 

 Parameters box, type “RFPAGE.” Do 
ork name for computer name” 

 resource to the group.

E-mail Gateway resource (if 

 and then select New > Resource. The 
rd opens.

escription boxes, enter “RightFax 

Generic Service.

up.

s box, enter the names of both nodes in 
 them and clicking Add.

dencies box, add the RightFax Server 
.

 Parameters box, type “RFEMAIL.” Do 
ork name for computer name” 

 resource to the group.

ce resources offline using Cluster 
ke the entire group offline. 

es must be taken offline using Cluster 
o will result in an immediate failover.
Chapter 6 Installing Rig

. In the Generic Service Parameters box, type “RFQUEUE.” Do 
not select the “use network name for computer name” 
checkbox.

. Click Finish to add the resource to the group.

o create the RightFax Remoting Service resource

. Right-click Resources, and then select New > Resource. The 
Generic Resource wizard opens.

. In the Name and Description boxes, enter “RightFax Remoting 
Service”.

. Set Resource Type to Generic Service.

. Select the RightFax group.

. In the Possible Owners box, enter the names of both nodes in 
the cluster by selecting them and clicking Add.

. In the Resource Dependencies box, add the RightFax file 
share name- “RightFax File Share”. 

. In the Generic Service Parameters box, type “RFREMOTE”. 
Do not select the “use network name for computer name” 
checkbox.

. Click Finish to add the resource to the group.

o create the RightFax Paging Module resource

. Right-click Resources, and then select New > Resource. The 
Generic Resource wizard opens.

. In both the Name and Description boxes, enter “RightFax 
Paging Module.”

. Set Resource Type to Generic Service.

. Select the RightFax group.

. In the Possible Owners box, enter the names of both nodes in 
the cluster by selecting them and clicking Add.

6. In the Resource Depen
share name- “RightFax 

7. In the Generic Service
not select the “use netw
checkbox.

8. Click Finish to add the

To create the RightFax 
installed)

1. Right-click Resources,
Generic Resource wiza

2. In both the Name and D
E-mail Gateway.”

3. Set Resource Type to 

4. Select the RightFax gro

5. In the Possible Owner
the cluster by selecting

6. In the Resource Depen
resource “RFSERVER”

7. In the Generic Service
not select the “use netw
checkbox.

8. Click Finish to add the

To license your cluster

1. Take the RightFax servi
Administrator. Do not ta

Warning  All RightFax servic
Administrator. Failure to do s
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tegration Module in a Windows 2003 

ions below if licensed for the Integration Module.

 node, open the RightFax Integration applet from 
ontrol Panel. 

gration applet does not appear in the Control Panel, 
 Files folder under the RightFax Directory, and open 

aunch the applet.

tion Wizard or manually configure the Integration 
 close the applet.

nge the RightFax Server name to the shared 
 the RightFax group.

ows registry and browse to the subkey: 
ARE\RightFax\Production\RFProd.

mand line for the three default printer inputs so 
P/IP ports rather than named pipes by using 

. The numbers at the end of the new command 
P/IP port numbers. You can select any port 

not in use on either node of the cluster. 
u may delete and recreate existing inputs, 
ust set the new inputs to the type of "TCP/IP 

ault Command Required Command 
Line

sten -c "makedoc 
 -p hflpr

portlstn -c "makedoc $$" 
-p 8201

sten -c "pfilter $$ | 
edoc" -p hfpcl

portlstn -c "pfilter $$ | 
makedoc" -p 8202

ten -c "pfilter -p $$ | 
edoc" -p hfps

portlstn -c "pfilter -p $$ | 
makedoc" -p 8203
2. License your cluster by contacting the RightFax product 
support group at (520) 320-7070. A support engineer will 
assist you through the registration process.

3. Bring all resources online after successfully licensing your 
cluster.

To complete the cluster installation

1. Bring all of the RightFax resources on-line.

2. From the node with ownership of the RightFax group, open 
Regedit.

3. Browse to HKLM\SOFTWARE\RightFax\Install\. Change the 
value RFServerName to reflect the shared network name of the 
RightFax group, not the name of the node.

4. Browse HKLM\SOFTWARE\RightFax\Production\. Change the 
value RightFaxServerName to the shared network name of the 
RightFax group.

5. Browse to HKLM\SOFTWARE\RightFax\Production\Servers. 
Here you will find a subkey with the same name as the node. 
Rename this subkey to the shared network name of the 
RightFax group.

6. From Cluster Administrator, verify that the RightFax group can 
be taken offline and online without errors. 

7. Move the group between the nodes, verifying that all the 
resources start correctly on each node. Correct any issues 
found before proceeding. 

8. Make sure the RightFax resources are online. Install remote 
BoardServers as required, pointing them to the shared network 
name of the RightFax cluster group, rather than the name of any 
individual node. When prompted during remote BoardServer 
installation, select the option to use an existing SQL Server, and 
supply the correct server name (clustered instance name if 
applicable) and logon information

Configuring the In
Cluster

Follow the instruct

1. From the active
the Windows C

Note  If the Inte
locate the Shared
rfprod_ctl.cpl to l

2. Run the Integra
Module. Do not

Important  Cha
network name of

3. Open the Wind
HKLM\SOFTW

4. Modify the com
that they use TC
the table below
lines are the TC
number that is 
Alternatively, yo
however, you m
Port"

Table 6d  

Printer 
Name

Def
Line

HostFax npli
$$"

PCL npli
mak

Postscript nplis
mak
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n Module Printers

enter \\<cluster_name>.

pen the Printers folder

n the cluster printer folder belonging to the 
rinter folder belonging to either node. If you 
usual way from Start, Settings, Printers, you 
e's printer folder.

ch of the printer inputs defined in the 

rt of the "Standard TCP/IP Port" type. 

IP address as the target IP address, and 
e. 

 type, click settings, and specify "RAW" 
 TCP/IP port number specified in the 

from the Production applet (8201 in the 
r step).

rinter ports for each of the other default 
PCL and HFPS as the port names, and 
rs specified in the applet.  Also create 
inter inputs to be used.

 each Integration print queue. Use the 
 HFPCL, and HFPS, and the previously 

eric, Plain Text as the printer driver for every 
ueue

gration Module

 Integration Module, add a virtual 
using IIS Manager, with the local path 
ction\Inbox directory on the shared drive. 
er the FTP service.
Chapter 6 Installing Rig

. If additional printer inputs are needed, create them in the same 
way using TCP/IP ports.  Named pipes will not function in the 
cluster environment.

. Click OK to close the applet and create the service.

. Verify that the RightFax Integration Module service is set to 
manual start.

. Move the group to the second node.

. Open the Integration applet on the second node. All 
configuration settings should be retained. Click OK to close the 
applet and create the service.

0.Verify that the RightFax Integration Module service is set to 
manual start.

reate a new Generic Service resource in the RightFax 
roup

. Right-click Resources, and then select New > Resource. The 
Generic Resource wizard opens.

. In both the Name and Description boxes, enter “RightFax 
Integration Module.”

. Set Resource Type to Generic Service.

. Select the RightFax group.

. In the Possible Owners box, enter the names of both nodes in 
the cluster by selecting them and clicking Add.

. In the Resource Dependencies box, add the RightFax Server 
resource “RFSERVER”.

. In the Generic Service Parameters box, type “RFPROD.” Do 
not select the “use network name for computer name” 
checkbox.

. Click Finish to add the resource to the group.

. Bring the new resource online.

0.Verify failover and failback is successful.

Configure the Integratio

1. Click Start > Run, and 

2. In Windows Explorer, o

Important  You must ope
virtual machine, not the p
access the printers in the 
are only opening the nod

3. Create new ports for ea
Integration applet.

4. Create a new printer po

5. Use the shared cluster 
HostFax as the port nam

6. Select "Custom" device
as the protocol, and the
Portlstn command line 
example from the earlie

7. Repeat to create new p
printer inputs, using HF
the TCP/IP port numbe
ports for any custom pr

8. Create new printers for
printer names HostFax,
created ports.

Important  Use only Gen
Integration Module print q

Using FTP with the Inte

If FTP is to be used for the
directory to BOTH nodes 
being the \RightFax\Produ
It is not necessary to clust
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Applying Service Packs or Hot Fixes
If it is necessary to apply a RightFax service pack or hot-fix after the 
installation on the cluster has been completed, follow these steps:

1. Run Cluster Administrator and stop all RightFax services. Do 
not take the RightFax file share offline.

2. Apply the update to the active node according to the 
instructions provided with the update.

3. Move the group containing the RightFax services to the next 
node without bringing them online.

4. Apply the update to the new node according to the instructions 
provided with the update.

5. Apply the update to any remote BoardServers and 
WorkServers, if applicable.

6. From Cluster Administrator, bring the RightFax services back 
online.

� � �
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ers share a SQL database. Common disk 
d RightFax resources. 
Chapter

er 7

alling and Configuring RightFax Data Sharing

haring with RightFax 9.3 
he capacity of RightFax servers can be multiplied by combining 
wo or more servers that share a common SQL database. This is 
ccomplished by installing and configuring multiple RightFax 
ervers to share a RightFax database and corresponding resource 
olders. Benefits of Data Sharing may include:

Increased throughput for sending faxes due to internal load 
sharing among RightFax services. 
Multiple RightFax servers share all SQL stored data (e.g., users, 
delegates, phonebook entries, distribution lists, and document 
data such as fax status). 

All received faxes are stored on the SQL server and are available 
to all clients in the network.

A common database helps maintain integrity of RightFax data. 
Redundant data is eliminated thus saving storage space. 

RightFax does not limit the number of RightFax servers that can 
share a common SQL database thus increasing scalability.
Remote RightFax services can be shared by multiple machines to 
balance the workload from many RightFax clients.

ote  This feature is only available on RightFax 9.3 Enterprise Servers 
nd must be purchased separately.

Server Topology
The following examples de
configurations.

Figure 7.1  Two RightFax serv
storage is used to store share
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tFax servers share a SQL database. DocTransport 
ices are located on remote servers to off-load 
RightFax servers. Dialing rules specify the 
es and RightFax servers from which documents will 
sk storage is used to store shared RightFax 
Figure 7.2  Two RightFax servers share a SQL database. DocTransport 
services are located on remote servers to off-load processing from the 
RightFax servers. Dialing rules specify the DocTransport services and 
RightFax servers from which documents will be sent. Common disk 
storage is used to store shared RightFax resources.

Figure 7.3  Two Righ
and WorkServer serv
processing from the 
DocTransport servic
be sent. Common di
resources.
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vers to Share a SQL 

 servers that share a SQL database, 
s below in conjunction with the 
lined in Chapter 3, “Installing the 
 or Chapter 6, “Installing RightFax in a 
s 2003 Cluster”.

int or make a copy of the Windows 
AL_MACHINE\ Software\RightFax so 

 any changes that have been made to 
n a typical shared database 
ation should be identical on each 

er on the first RightFax server computer. 
se as you are prompted during the 

es on the first RightFax server computer.

x server computer, run the RightFax 
am. 

point the second RightFax server to the 
 defined when you installed the first 

you will be prompted to overwrite or 
atabase. Select to Append.

es on the second RightFax server, as 
 avoid license conflicts and violations, all 
 that share a common SQL database 
ensed features activated.

 7 for each added RightFax server.
Chapter

igure 7.4  Two RightFax servers share a SQL database. Common disk 
torage is used to store shared RightFax resources. An application traffic 
anager, such as BIG IP, directs RightFax client traffic to available 
ightFax servers. 

m Requirements 
he requirements for RightFax Servers are described on page 9, 
Hardware and Software Requirements”. In addition to these 
equirements, you must also possess a minimum of two servers 
apable of network communication. Each of these must be 

icensed for the ‘Server Collective’ feature. 

Installing RightFax Ser
Database

To install multiple RightFax
complete the general step
installation instructions out
RightFax Server Software”
Windows 2000 or Window

1. If you are upgrading, pr
registry key HKEY_LOC
that you have a copy of
customize the system. I
configuration, customiz
RightFax server.

2. Install the RightFax serv
Define the SQL databa
installation.

3. Activate licensed featur

4. On the second RightFa
server installation progr

5. During the installation, 
SQL database that you
RightFax server.

6. During the installation, 
append to the existing d

7. Activate licensed featur
described in step 2. To
of the RightFax servers
must have the same lic

8. Repeat steps 4 through
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sent and received faxes stored as compressed 
es).

aphic images of user signatures for placement 

 the names of overlay form files).

x cover sheets).
ins outbound files from all submission methods 
le being processed into fax images, such as 
eue spool files).
xt files created by the OCR process).

ins transaction files for each fax sent via e-mail 
s).
rs can be located in common disk storage, such 
etwork (SAN), network share on file server, or 

 a local drive on one of the RightFax servers. The 
cessible to all the servers in the shared 

server, create shared access to these files using 
r Configuration dialog box, Data Sharing tab. 
cations can be expressed differently for each 
issions and network layout. Each server can be 

unique paths and user accounts to the same 
r each type of resource file. Services that 
ge and other files must be given service 

ess to the specified paths.
Providing Access to Shared Resource Folders
Each RightFax Server that is licensed for Server Collective (Data 
Sharing) will have a Data Sharing tab within the Server module 
configuration as shown below. 

Figure 7.5  The Server module Data Sharing Tab.

The dialog boxes within the Data Sharing tab represent folders that 
must be shared among all the RightFax servers within a Data 
Sharing environment. Share permissions must be given to the 
account used to run both the Server module and DocTransport 
module. This account must have full control of these folders. 
Choosing this account can be done by click the Select Service 
Account button. A complete list and description of these folders is 

provided below.

� Image (contains 
graphic image fil

� SIG (contains gr
on faxes).

� Papers (contains

� FCS (contains fa
� Outgoing (conta

that are held whi
temporary fax qu

� BFT (contains te

� CmdData (conta
or via SecureDoc

Each of these folde
as a storage area n
network access to
folders must be ac
configuration.

On each RightFax 
the RightFax Serve
Access to these lo
server due to perm
configured to use 
storage location fo
directly access ima
accounts with acc



 7 Installing and Configuring RightFax Data Sharing 79

F

N
r

Con
T
c

�

�

�

T
B
B

T
s
s
D
c

A
I

A
c
p

erver using the shared database, not 
itially received the job.

t from a specific server, use dialing 
dialing rules can be found in the 
uide.

t be sent by a particular DocTransport 
o transfer the job to the DocTransport 
on page 76 for a basic illustration.

enance
 of daily tasks that help maintain an 

aintenance tasks may be run by any 
serve basis.

es the age of each document on the 
ocument exceeds the age limit, it is 
arked documents will later be deleted by 
ents that are marked for deletion can be 
rged. The age limit for documents is 
user group (in Enterprise Fax Manager). 
d for deletion can also be queried for 

ves documents from the SQL database 
eletion and have reached the configured 
deletes the corresponding image files 
e directories on the RightFax servers in 
ne event triggers the aging and purging 
Chapter

or Example:Server A may access a local storage area network 
(SAN) using the path S:\RightFax\Image and use the 
local system account for RightFax services to access 
this path. Server B might access the same location 
remotely using the path \\ServerA\RightFax\Image which 
would require use of an account that had permissions to 
access that network path (such as, DomainA\RightFax).

ote  On remote BoardServers and WorkServers, these shared 
esources must be configured in the Windows registry.

figuring Remote Services
he following RightFax services can be installed on remote 
omputers.

DocTransport, which specifies the methods by which documents 
will be transmitted and converts and copies received documents 
to the Image directory.
BoardServer, which communicates between the RightFax server 
and fax boards.

WorkServer, which performs processor-intensive functions such 
as cover sheet generation, print-to-fax conversion, and optical 
character recognition.

o support remote fax board services, the DocTransport and 
oardServer modules must be installed together on Remote 
oardServer computers.

he DocTransport module must be defined on each RightFax 
erver. That is, whether local or remote, DocTransport modules 
hould be discrete and should not be shared. A remote 
ocTransport module can connect to one RightFax server. It 
annot access multiple RightFax servers.

 remote BoardServer module can connect to one RightFax server. 
t cannot access multiple RightFax servers.

 remote WorkServer can connect to one RightFax server. It 
annot access multiple RightFax servers. Refer to Figure 2 on 
age 76 for a basic illustration of remote services.

Using Dialing Rules
A fax may be sent by any s
necessarily the one that in

To specify that a fax be sen
rules. More information on 
RightFax Administrator’s G

To specify that a documen
module, use dialing rules t
module. Refer to Figure 3 

Performing Daily Maint
Maintenance is a collection
efficient SQL database. M
server on a first come first 

Aging and Purging
The aging process evaluat
RightFax server. When a d
marked for deletion. The m
the purge process. Docum
recovered until they are pu
defined for each RightFax 
Documents that are marke
reporting purposes.

The purging process remo
that are both marked for d
limit. The purging process 
that are stored in the Imag
the shared configuration. O
process.
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aintenance Processes
 process is an event that is stored in the event 
 server. One RightFax server will perform 
 a maintenance event is queued, on a first-come, 
Aging is performed before purging. 

r maintenance to begin is 2 AM. The time is set 
rver Configuration dialog box, Advanced tab.

enance Logs
nance process are stored in the 
 folder on the server that performed the 
s are:

ndPurging.log

Scan.log

covery.log
Orphan Scanning
The orphan process scans the RightFax\Image directories on the 
RightFax servers for fax image files that are not referenced by any 
document or library document in the SQL database. The image 
files are called “orphans” because RightFax has no record of their 
existence and cannot access them. 

To manually delete orphan image files from the RightFax server, use 
the Orphan.exe utility.

Recovery
The RightFax 9.3 the event queue is stored in the SQL database 
on the SQL server, and it is shared among RightFax servers. The 
queue is persistent, that is, it retains its objects and values if the 
RightFax Server module stops. If one of the RightFax Server 
modules in the shared configuration stops, then it is not necessary 
to rebuild the queue. The recovery process is performed daily on 
the RightFax servers as a fail safe. 

Configuring the M
Each maintenance
queue on the SQL
maintenance when
first-served basis. 

The default time fo
in the RightFax Se

Viewing the Maint
Logs of the mainte
RightFax\Database
process. These log

� MaintAgingA

� MaintOrphan

� MaintDocRe

� � �
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es all of the user guides available for 
tFax components that each guide 

u must have Adobe Acrobat Reader 
robat Reader can be found on the RightFax 

Docs folder.

n

nstalling, configuring, and using the 
F Module.

nstalling, configuring, and using the 
R Converter Module.

nstalling, configuring, and using the 
R Router Module.

nsive guide to configuring and 
 all RightFax servers.

 for C programmers and Visual Basic 
rs for using the RightFax API. This guide 
ble through the RightFax Developer’s 
er 8

umentation and Support

ax Documentation
ocumentation for the RightFax server, the RightFax client 
pplications, and all of the RightFax components and modules is 

nstalled in PDF format on the RightFax server. For your 
onvenience, Captaris also provides three of these guides in 
rinted form: the RightFax Installation Guide, the RightFax 
dministrator’s Guide, and the RightFax Integration Module Guide 

provided only with a licensed copy of the RightFax Integration 
odule). The remaining guides are formatted to be easily viewed 
n-screen or printed.

ll of the RightFax user guides (including PDF versions of the 
rinted guides) are located in the RightFax\Docs folder on the 
ightFax server and on the product CD. In addition, most of these 
ocuments can be downloaded from the RightFax Web site at 
ww.captaris.com/customer_support/tech_docs/5609.html.

The following table describ
RightFax and lists the Righ
supports.

Note  To view these files, yo
installed. A copy of Adobe Ac
server installation CD in the 

Table 8a  RightFax User Guides

Guide name Descriptio

Activating and Using 
PDF Module

A guide to i
RightFax PD

Activating and Using 
the OCR Converter 
Module

A guide to i
RightFax OC

Activating and Using 
the OCR Router 
Module

A guide to i
RightFax OC

Administrator’s 
Guide

A comprehe
maintaining

API Reference Guide A reference
programme
is only availa
Network.
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uide to installing, configuring, and using the 
htFax Lotus Notes Module.

uide to installing, configuring, and using the 
htFax Microsoft Exchange Module.

uide to installing the RightFax server, upgrading 
 server, and adding new components.

uide to configuring RightFax to work with the 
rAction contact management system.

uide to installing, configuring, and using the 
htFax Integration Module.

uide to installing, configuring, and using the 
htFax InternetLink Module.

uide to installing, configuring, and using the 
htFax SecureDocs Module.

uide to installing, configuring, and using the 
htFax SNMP Alerting Module.

uide to installing, configuring, and using RightFax 
Connect.

es (Continued)

cription
Client for Lotus 
Notes Quick 
Reference Card

A reference card for users who will send and manage 
faxes with the RightFax Gateway for Lotus Notes.

Client for Microsoft 
Outlook Quick 
Reference Card

A reference card for users who will send and manage 
faxes with the RightFax Gateway for Microsoft 
Exchange.

COM Reference 
Guide

A guide to using the RightFax COM module for 
creating custom RightFax applications with Visual 
Basic. This guide is provided in PDF format on the 
RightFax COM Module installation CD.

Connector for Oracle 
CRM Guide

A guide to installing, configuring, and using the 
RightFax Connector for Oracle CRM.

Connector for Oracle
E-business Suite 
Guide

A guide to installing, configuring, and using the 
RightFax Connector for Oracle E-business Suite.

Connector for FileNet 
P8 Guide

A guide to installing, configuring, and using the 
RightFax Connector for Panagon Image Services. 
This guide is only available with the FileNet P8 
integration software.

Connector for SAP 
R/3 Guide

A guide to installing, configuring, and using the 
RightFax Connector for SAP R/3.

Docs-on-Demand 
Guide

A guide to installing, configuring, and using RightFax 
Docs-on-Demand.

Document 
Management 
Connector Guide

A guide to integrating RightFax with iManage and 
Hummingbird content management applications.

Fax Board Guide A guide to all the fax boards supported by RightFax, 
including required hardware and software 
configuration.

FaxUtil Quick 
Reference Card

A reference card for users who will send and manage 
faxes with RightFax FaxUtil.

Table 8a  RightFax User Guides (Continued)

Guide name Description

RightFax Lotus Notes 
Module Guide

A g
Rig

RightFax Microsoft 
Exchange Module 
Guide

A g
Rig

Installation Guide A g
the

Installing and Using 
the InterAction 
Integration Software

A g
Inte

Integration Module 
Guide

A g
Rig

InternetLink Module 
Guide

A g
Rig

SecureDocs Module 
Guide

A g
Rig

SNMP Alerting 
Module Guide

A g
Rig

TeleConnect Guide A g
Tele

Table 8a  RightFax User Guid

Guide name Des
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sers can select Contact Information, 
t lists RightFax technical support 

mation Dialog Box

pears in English with RightFax contact 
it the text to provide customized 

the text file Contact.txt located in the 
 RightFax server. You can enter 24 lines 
ters per line.

es
 the skills to optimize your RightFax 
ve technical, administrative, and user 
 full utilization and understanding of 
r classes are held at the state-of-the-art 
 Tucson, Arizona, throughout the year, or 
nience of training at one of our regional 
s and computer-based training tools are 
ormation on RightFax training, please 
g Help Online
ost of the RightFax windows and dialog boxes include 

ontext-sensitive help. Typically, this help describes each field and 
ption in a dialog box. This context-sensitive help can be launched 

rom the question mark icon in the title bar of a dialog box.

Click this icon, and then click any option on the dialog box to view 
its definition.

Or, press F1 to view a definition.

nline help for tasks or conceptual topics also is available. View 
his help by selecting the Help menu. You can browse the help for 
 topic or use the index to look up key words and terms.

he RightFax Web site offers the latest product information. 
pdated documentation, a searchable customer support 
nowledgebase, software downloads, and the latest product 
fferings are all online at www.captaris.com/rightfax.

Editing Contact Informat
In the FaxUtil Help menu, u
and a dialog box opens tha
contact information.

Figure 8.1  The Contact Infor

This contact information ap
information, but you can ed
information. To do so, edit 
\RightFax\Bin folder on the
of text and up to 59 charac

Captaris Training Servic
RightFax training gives you
solution. Our comprehensi
training programs produce
RightFax products. Regula
RightFax Training Center in
you can choose the conve
locations. Training material
also available. For more inf

Click the
question mark icon

Select the
Help menu
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pport:  
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A

Voice: (520) 320-7070
Fax: (520) 321-7461
Web: www.captaris.com/rightfax
E-mail: tech@captaris.com

ific time, Monday through Friday

ific time, Saturday

istration: (520) 320-7000
visit our Web site at www.captaris.com/training, or call us at 
(520) 320-7098 and let us help you develop a customized training 
plan for your organization.

Captaris Implementation Services
Captaris Implementation Services offers a team of highly skilled 
engineers who are experts in the deployment, implementation, and 
integration of RightFax solutions. Implementation services include 
installation and configuration, upgrades, configuration review, and 
advanced integration services. Whether it's through remote dial-in, 
an on-site implementation, or a combination of both, the 
Implementation Services team can quickly integrate RightFax 
solutions with your existing applications.

Customer Support
Your Customer Support Guide includes detailed information about 
the support options available to RightFax customers. Please fill out 
the RightFax Software Warranty & Registration Card and return it 
immediately. If you have questions of a technical nature, contact 
your organization’s RightFax administrator or network administrator 
before calling the RightFax customer support department. On the 
RightFax Web site, a database of customer support knowledge 
contains a wealth of information on installing, configuring, and 
maintaining RightFax software.

RightFax Customer Su

Captaris
Suite 210
6303 E. Tanque Verde
Tucson, Arizona 85715 US

5:00 A.M. to 5:00 P.M. Pac

7:00 A.M. to 3:00 P.M. Pac

Support Sales and Admin
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